# Contents

Adobe Report Builder Help.............................................................................................................6

What's New in Report Builder...........................................................................................................7
  Report Builder 5.6..........................................................................................................................7
  Report Builder 5.5..........................................................................................................................7
  Report Builder 5.4..........................................................................................................................7
  Report Builder 5.3..........................................................................................................................8
  Report Builder 5.2..........................................................................................................................8

Report Builder Setup ......................................................................................................................9
  System Requirements...................................................................................................................9
  Install Report Builder...............................................................................................................9
  Upgrade Report Builder.............................................................................................................9
  Report Builder Sign-In...............................................................................................................11
    Report Builder Sign-In.............................................................................................................13
  Uninstall Report Builder..........................................................................................................13
  Invoke Report Builder Functionality from Microsoft Excel Functions.....................................13

Overview.......................................................................................................................................16
  Report Builder Toolbar.............................................................................................................16
  Request Wizard Interface.........................................................................................................16
    Request Wizard Step 1............................................................................................................16
    Request Wizard Step 2............................................................................................................17

Data Requests - Request Wizard Step 1..........................................................................................23
  How to create a data request......................................................................................................23
  Report Suites..............................................................................................................................24
    Select a Report Suite...............................................................................................................24
    Select a Report Suite from an Existing Request in Excel.......................................................24
Use Excel to Locate a Report Suite ID.....................................................................................................24
Manage Segments.................................................................................................................................24
Allow Publishing List Overrides...........................................................................................................29
Report Types........................................................................................................................................30
Path and Path Fallout Reports in Report Builder.....................................................................................30
Select a Report Type................................................................................................................................36
Import Bookmarked Reports and Dashboard Reportlets.................................................................36
Date Ranges...........................................................................................................................................38
Preset Dates...........................................................................................................................................38
Fixed Dates and Saved Date Ranges........................................................................................................39
Rolling Dates........................................................................................................................................39
Real-Time Reports..................................................................................................................................40
Customized Date Expressions..................................................................................................................41
Dates from a Cell....................................................................................................................................44
Granularity.............................................................................................................................................44
Custom Calendar....................................................................................................................................44
Interactive Controls...............................................................................................................................45

Layout - Request Wizard Step 2.............................................................................................................49
Metrics and Dimensions..........................................................................................................................49
Calculated Metrics.................................................................................................................................49
Combine Traffic and Commerce Metrics in the same Request..............................................................51
User Access Permissions for Dimensions and Metrics...........................................................................52
Add Metrics and Dimensions..................................................................................................................53
Anomaly Detection...............................................................................................................................59
Configure an anomaly detection request................................................................................................60
Format the Date....................................................................................................................................61
Format Display Headers.........................................................................................................................62
Hide or Show Headers.............................................................................................................................63
Delete Output Mapping............................................................................................................................63
Name a Request....................................................................................................................................63
Prepend and Postpend Text to Cells........................................................................................................64
Configure the Custom Layout....................................................................................................................64
Map Metrics and Dimensions to Cells...................................................................................................... 64
Create a Microchart................................................................................................................................. 66
Filter Dimensions...................................................................................................................................... 66
Most Popular Filtering................................................................................................................................. 68
Specific Filters........................................................................................................................................... 70
Saved Filters............................................................................................................................................. 72

Manage Requests....................................................................................................................................... 73
Manage Requests - Definitions................................................................................................................... 73
Diagnostic Messages................................................................................................................................. 74
Sort Ascending or Descending.................................................................................................................... 74
Protected Worksheet Elements.................................................................................................................. 74
Edit Multiple Requests.............................................................................................................................. 75
  Edit Metrics Across Multiple Requests................................................................................................... 75
Refresh a Request....................................................................................................................................... 78
Refresh Requests for All Sheets................................................................................................................ 78
Add Dependent Requests........................................................................................................................... 78
  Classification.......................................................................................................................................... 79
Copy Requests.......................................................................................................................................... 79
  Copy Simple Requests.............................................................................................................................. 79
  Copy Adjacent Requests.......................................................................................................................... 80
  Copy Worksheets.................................................................................................................................... 80
  Copy Requests and Worksheets between Workbooks......................................................................... 81
Create More than One Copy of a Request.................................................................................................. 81
  Copy Referential Requests....................................................................................................................... 82
Save a Workbook with Requests............................................................................................................... 83
Specify Conditional Formatting................................................................................................................ 83
Offline Mode for Creating and Editing Requests.................................................................................... 83

Report Builder Options.............................................................................................................................. 85

Schedule Report Requests......................................................................................................................... 87
  Schedule a Data Request........................................................................................................................ 87
## Adobe Report Builder Help

Adobe Report Builder is an add-in for Microsoft Excel. Report Builder lets you build customized requests from reporting and analytics data, which you can insert into your Excel worksheets. Requests can dynamically reference cells within your worksheet, and you can update and customize how Report Builder presents the data.

### Latest Information

* **Important:** Update your installation of Report Builder to the latest version. This update is a pre-requisite for running the Analytics user ID migration to the Admin Console, beginning in April 2018.

  See [Analytics User Migration to the Admin Console](#) for migration information.

* **Important:** Due to the end of support for TLS 1.0, we recommended that Adobe Report Builder (ARB) users download ARB v5.6.21 prior to September 13, 2018. After that date, prior versions of ARB will not be supported.

### Popular Help Topics

- Setup, Installation, and Login
- Feature Overview
- Schedule Report Requests
- Troubleshooting and Best Practices for Report Builder
- What are my options for creating custom date ranges?
- Why can't I see my segments in Report Builder?
- What are the Report Builder limits regarding the number of scheduled reports?

### Common Questions and Troubleshooting

- How do I create a data request?
- Troubleshooting and Best Practices for Report Builder

### Experience Cloud Resources

- Adobe Analytics Community
- Experience Cloud Release Notes
- Product Documentation Home
- Developer
- Idea Exchange
- Adobe Training and Tutorials
- Featured Solutions Center

### Reports & Analytics Help

- Analysis Workspace Help
- Reports & Analytics Help
- Analytics Reference

Help on Admin Tools, reports, and metrics.
What's New in Report Builder

Lists current and previous releases and their features.

- Report Builder 5.6
- Report Builder 5.5
- Report Builder 5.4
- Report Builder 5.3
- Report Builder 5.2

Report Builder 5.6

Edit Metrics across Multiple Requests

The Edit Multiple Metrics feature lets you easily add, remove, or replace metrics in a pre-existing group of requests.

For more information, see Edit Metrics Across Multiple Requests.

Report Builder 5.5

Publishing to Power BI with Report Builder 5.5

Microsoft Power BI is a suite of business analytics dashboards to analyze data and share insights. The Adobe Analytics integration with Power BI lets you visualize Report Builder Analytics data within Microsoft Power BI and easily share it across your organization.

Previously you, as an Analyst, would schedule Report Builder workbooks to be disseminated via email (or ftp). You can now give your business user stakeholders access (from within their Power BI accounts) to accurate and up-to-date data in a web-based environment that is accessible across platforms and devices.

Combining the report-generation capability of Report Builder with the visualization features of Power BI makes information more accessible to everyone in your organization. With Power BI, you can also integrate Adobe Analytics with other data sources (e.g. point of sale, CRM) to discover unique customer insights, associations, and opportunities.

More...

Report Builder 5.4

- Better management and editing of segments across multiple requests.

  New options under Edit Multiple Requests let you add, remove, replace, and replace all segment(s) within multiple target requests. More...

- New link to the Adobe Report Builder Community

  The new Adobe Community link under Help takes you to the Adobe Community Forum with the search narrowed to Report Builder issues. The Adobe Community is a great way to ask your Report Builder peers questions about the application and to find out about or share best practices.

  Note: You can change to a different locale by going to the main Adobe Forums page, under International Forums.
• **Enhanced login security**

In addition to a *new login screen*, the Standard Report Builder login features a more secure authentication process, based on the OAuth authorization framework.

## Report Builder 5.3

- **Virtual Report Suites**
- **Experience Cloud Audiences in Analytics**
- **AEM Assets Reporting**

## Report Builder 5.2

- **Calculated Metrics**

  Report Builder 5.2 supports Adobe Analytics [*Unified Calculated Metrics*]. Among other innovations, all calculated metrics now have a global ID - they are no longer restricted to one report suite.

- **Enhanced search for reports and metrics**

  With more eVars and events being added to Adobe Analytics, the number of reports and metrics offered in Adobe Report Builder is increasing significantly. In order to simplify the search, a couple of new search bars have been added to the Request Wizard: one for *report search* and one to search for *metrics*.

- **Customer Attributes**

  Customer attributes are stored in new type of element called VisAttr, which can be configured as a dimension or a metric. For more detailed information on how to upload customer attributes, see the *Experience Cloud help*. 
Report Builder Setup
System requirements and installation information for Report Builder.

System Requirements
System recommendations and prerequisites.

• Windows XP or higher
• 32-bit or 64-bit Microsoft Excel 2007 or higher
• OS X is not supported

Prerequisites
• Your organization’s contract includes Report Builder for Excel.
• Your user name is part of the pre-defined Report Builder user group. This requirement includes Analytics administrators.
• The user must be running Windows and logged in as an administrator.

Install Report Builder
Steps that describe how to install Report Builder.

⚠️ Important: Update your installation of Report Builder to the latest version. This update is a pre-requisite for running the Analytics user ID migration to the Admin Console, beginning in April 2018.

See Analytics User Migration to the Admin Console for migration information.

2. Click Download Now to download the 32-bit or 64-bit version (depending on the MS Excel version installed).
3. Open the downloaded installer package.
4. Follow the installation wizard.
5. Open/Restart MS Excel to get the Add-Ins menu to show up.
6. Go to Add-Ins > Sign In.
   Follow the instructions in Report Builder Sign-In.

Upgrade Report Builder
Steps for and considerations regarding upgrading Report Builder.

Upgrade FAQ

Q: Do I keep the old version of Report Builder when I upgrade?
A: No, the old version will be removed.

Q: Will I lose any of my existing reports?
A: No, all existing reports will continue to work.

Q: Do I have to re-authenticate to the new version?
A: No, all your settings, including authentication settings, will continue to work.

**Upgrade Instructions**

1. Log in to your current version of Report Builder.
2. Go to the **Options** menu to upgrade to the latest version. Your current version number is shown towards the bottom of the Options dialog.

![Upgrade Dialog](image)

3. If a new version is available, click **Update**. The button will show which version you are updating to, for example: “Update to version 5.0.50”

   **Note:** *If this button is greyed out, no new version of Report Builder is available.*

4. Optionally select the **Update when a new version is available** checkbox. In the future, this will start the update process automatically when a new version becomes available.
5. When the setup screen appears, click **Next >**.

![Setup Screen](image)

6. Once the upgrade is complete, log back in to report builder.
Manual Upgrade Instructions
You can always get the latest version of Report Builder from Adobe Analytics.

1. Log in to Adobe Analytics and go to **Tools**.
2. Click **Report Builder**.
3. On the **Overview** screen, select the 32-bit or 64-bit version.
4. Click **Download Now!**.

Report Builder Sign-In

Information about the three ways to sign in to Report Builder.

Currently, the following login options are available when you click **Sign In** to Report Builder.

- **Standard**
- **Single Sign-On**
- **Experience Cloud and Single Sign-On**

**Standard**
Use this login if you want to sign in to Report Builder using your Adobe Analytics credentials.

Report Builder Login - Field Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>The Company login credential that you use for Adobe Analytics.</td>
</tr>
<tr>
<td>Username</td>
<td>The Username login that you use for Adobe Analytics. Scheduled tasks for a user are linked to the username. You can view your scheduled tasks from any computer if you log in to report builder with the same login credentials.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>Your Analytics password.</td>
</tr>
<tr>
<td>Remember me</td>
<td>Login information is encrypted and stored in a user profile file on the machine where Report Builder is installed. Because login information is saved, anyone using the same PC as the report creator who opens a spreadsheet containing a report can refresh and edit the data. If you share your computer with others and you wish to keep the spreadsheet data private, do not enable this option. To disable your automatic login setting, click Log in With Different Credentials on the Toolbar and disable Remember Me.</td>
</tr>
<tr>
<td>Use a Proxy Server</td>
<td>Enable if you are accessing the Internet through a proxy server and are required to provide a proxy username and password.</td>
</tr>
</tbody>
</table>

**Single Sign-On**

This (legacy) single sign-on logs you in to Adobe Analytics only, not the entire Experience Cloud.

You can also type in a domain and the system will recognize the domain and redirect you to your company’s sign-in page to log in to Adobe Analytics.

**Experience Cloud**

The Experience Cloud login lets you use your Enterprise ID (email and password) to log in to the Adobe Experience Cloud. Click **Sign In > Sign in with an Enterprise ID** to be redirected to your company’s single sign-on page. For more information on Enterprise ID, click here.

💡 **Note:** The Experience Cloud login is session based and the token expires after 30 days.
Sign in to Report Builder

Steps that describe how to log in to Report Builder.

1. In Excel, click **Add-Ins**.
2. Click **Sign In**, and specify the method (Experience Cloud, Single Sign-on, and Standard).
   - Other actions that sign you in include:
     - Clicking **Create**.
     - **Selecting a request in the Request Manager**, then clicking **Add** or **Manage**.
     - Double-clicking on a request in Excel.
3. Complete the fields on the **Login** page, then click **OK**.

Uninstall Report Builder

Steps that describe how to uninstall Adobe Report Builder.

1. Ensure that Microsoft Excel is closed.
2. Click **Start > Control Panel**.
3. In Windows 7 or Vista, click Uninstall a program. In Windows XP, click **Add/Remove Programs**.
4. A list of installed programs will appear. Right-click Adobe Report Builder and select **Uninstall**.
5. The uninstall wizard window will pop up. Click **Uninstall**.
   - If you wish to completely remove all files and folders from your Program Files directory, follow these steps after uninstalling Report Builder:
6. Click **Start > Computer**.
7. Navigate to `C:\Program Files\Adobe\` or, if on a 64-bit version of Windows, `C:\Program Files (x86)\Adobe`.
8. Delete the Report Builder folder in this directory, if it is still there.

Invoke Report Builder Functionality from Microsoft Excel Functions

This ability further integrates Report Builder usage within the natural Excel workflow, without requiring you to access the Report Builder user interface.

For example, you may want to automatically refresh Report Builder requests whose input filter is based on data pulled in Excel from other sources. You can now do this using the string `RefreshRequestsInCellsRange(..)` function. All calls are asynchronous. They return immediately and do not wait for a call to fully execute.

**Note:** You **must have Report Builder 5.0 (or later) installed for this functionality to work.**

Here is a table with the list of exposed functions:

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>string AsyncRefreshAll()</td>
<td>Refreshes all Report Builder requests present in a workbook.</td>
</tr>
<tr>
<td>Function Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>string AsyncRefreshRange(string rangeAddressInA1Format)</td>
<td>Refreshes all Report Builder requests present in the specified cell range address (a string expression representing a range of cell in A1 format, for example &quot;Sheet1!A2:A10&quot;).</td>
</tr>
<tr>
<td>string AsyncRefreshRangeAltTextParam()</td>
<td>Refreshes all Report Builder requests present in the specified cell range that is passed through the Alternative Text of the Ms Form Control.</td>
</tr>
<tr>
<td>string AsyncRefreshActiveWorksheet()</td>
<td>Refreshes all Report Builder requests present in the active worksheet.</td>
</tr>
<tr>
<td>string AsyncRefreshWorksheet(string worksheetName)</td>
<td>Refreshes all Report Builder requests present in the specified worksheet (the worksheet name as it appears on the tab.)</td>
</tr>
<tr>
<td>string AsyncRefreshWorksheetAltTextParam();</td>
<td>Refreshes all Report Builder requests present in the specific worksheet name that was passed through the Alternative Text of the Ms Form Control</td>
</tr>
<tr>
<td>string GetLastRunStatus()</td>
<td>Returns a string that describes the status of the last run.</td>
</tr>
</tbody>
</table>

To access these functions within report builder, go to **Formulas > Insert Function**. At the bottom of the list of categories, you will find Adobe.ReportBuilder.Bridge:

![Insert Function](image)

**Using these Functions in a Formula**

For example, the formula

```excel
=IF(OR(ISTEXT(P5),ISBLANK(P5)),AsyncRefreshRange("P9"),"")
```

says "If the value in cell P5 is text or is blank, refresh the range that is in cell P9."

**Using Report Builder Functions with Format Control**

You can now assign a macro to a control you created and that control can be a function that refreshes a workbook request. For example, the function AsyncRefreshActiveWorksheet will refresh all requests in a worksheet. Sometimes, though, you may want to refresh only certain requests, not all.

1. Set the macro parameter.
2. Right-click the control and select **Assign Macro**.
3. Enter the report builder function name (no parameters or parentheses.)
Passing Parameters to Report Builder Functions via Format Control

The two functions that take a parameter can be used with Format Control, but only via the Alt Text field:

- `AsyncRefreshRange(string rangeAddressInA1Format)`
- `AsyncRefreshWorksheet(string worksheetName)`

1. Right-click the control and select **Format Control**.

2. Click the **Alt Text** tab.

3. Under **Alternative text**, enter the cell range that you want refreshed.
4. Open the list of report builder parameters under **Formulas > Insert Function > Adobe.ReportBuilder.Bridge**.
5. Pick one of the two functions that end with `AltTextParam` and click **OK**.
Overview

Information to help you become familiar with Report Builder.

See *Report Descriptions* for information about Reports and Analytics.

Report Builder Toolbar

Information to help you understand the function of the buttons on the Report Builder toolbar.

After you install Report Builder and launch Excel, click **Add-Ins**.

- **Sign In**: Displays the *Login* form so that you can log in with your credentials or as a different user. Also displays your company name after login. See *Sign in to Report Builder*.
- **Create**: Launches the **Request Wizard**. If you are not logged in, you are prompted to do so. See *Data Requests - Request Wizard Step 1*.
- **Manage**: Launches the **Request Manager**. You can view status, edit, refresh, delete, and manage all Report Builder data requests embedded in your Excel workbook. You can perform these functions on individual requests or on multiple requests at one time. See *Manage Requests*.
- **Refresh**: Refreshes the data for all requests embedded in the Excel workbook. See *Refresh a Request*.
- **Format**: Lets you set conditional formatting to spreadsheet cells. See *Specify Conditional Formatting*.
- **Schedule**: Lets you schedule reports to send according to the time and file format that you define. See *Schedule Report Requests*.
- **Library**: Launches the **Workbook Library** so that you can upload a report builder Excel workbook that you want to share. You can also download and edit shared workbooks. See *Workbook Library*.
- **Options**: Lets you specify whether you want to be prompted for the **As Of** (Now) date when refreshing requests, and lets you enable logging for troubleshooting purposes. See *Options*.
- **Locked/Unlocked**: You can protect all requests in a workbook against adding and editing requests by locking the workbook. This enables offline editing of workbooks by pausing all report requests for more efficient editing. See *Lock/Unlock Workbooks*.
- **Help**: Launches the Report Builder help documentation you are currently looking at.

Request Wizard Interface

Report Builder includes two primary configuration forms. On the first form, you select the report suite, report type, and configure dates. On the second form, you select whether to create a pivot-style layout or to use the custom layout.

Request Wizard Step 1

On the **Request Wizard: Step 1** form, you select the report suite, report type, segments, and configure dates.
1. **Report Suite**: The list of report suites available to you based on your login credentials. See *Select a Report Suite*.

2. **Range Selector**: Lets you select a report suite ID from a cell in Excel. See *Select a Report Suite*.

3. **Segment**: Segments are custom subsets of data, or data filtered by rules that you create. Segments are based on hits, visits, and visitors. See the *Analytics Segmentation Guide* for more information about segments.

   For example, you can run a **Pages Report**, and then apply a First Time Visits segment.

4. **Allow Publishing List Override**: When you schedule a report, you can choose a publishing list to use for distribution. Publishing lists are set up in *Analytics > Admin tools*. The report suite for this request is replaced by the report suite ID assigned to each recipient in the publishing list. See *Allow Publishing List Overrides*.

5. **Report Type**: Specifies the base report you want to run in your data request. You run one report per request, and that report can have one-to-many dimensions and one-to-many metrics. Metrics and dimensions for a report type are displayed on the *Request Wizard; Step 2* interface. See *Report Types*.

6. **Date Ranges**: Defines the time span covered by the request. Several types of request time periods are available, such as preset, fixed, and rolling. The maximum number of periods is 366. You can also choose a date range specified by a cell, and save date ranges as templates for later use.

   See *Date Ranges*

7. **Apply Granularity**: Specifies the level of time-based detail that is included in the report. See *Granularity*.

### Request Wizard Step 2

On the **Request Wizard: Step 2** form, you select whether to create a pivot-style layout or to use the custom layout.

**Pivot Layout**

The Request Wizard: Step 2 dialog box lets you configure a request's layout type, formatting, and specify which metrics to display and the dimensions to use for further breakdown reporting.

This example shows the settings available when you enable the **Pivot Layout** setting.
1. Metrics and Dimensions

Metrics are quantitative information about activity on your website, such as Page Views, Visitor Profile, Click-throughs, Reloads, Average Time Spent, Date, Units, and so on.
Metrics are numerical values. Dimensions are descriptions or characteristics of metric data that can be viewed and compared, such as in breakdown reports. Dimensions are non-numeric values and dates, such as gender, month, age, loyalty, monitor resolution, and so on. On the Dimensions tab, the system displays dimensions that break down, or are a classification of any base report you select on Step 1, and on the configuration of the report suite. The list of metrics and dimensions follow the menu layout displayed in Reports & Analytics.

When you drop a dimension to the layout grids, Report Builder removes them from the tree view and recalculates the list of remaining dimensions available. For more information, see Add Metrics and Dimensions.

2. Pivot Layout

Provides a row, column, and metric grid for layout, similar to standard Excel tables. Using this layout, you can add breakdown requests within an original request. See Pivot Layout.

3. Custom Layout

Provides most of the functionality of the Pivot Layout setting but lets you choose where each item in the grid should be located in the spreadsheet. This layout provides the flexibility available in previous report builder releases. See Configure the Custom Layout.

4. Select Insert Location

Lets you specify the location in the Excel workbook for your data request. For each new request you add to a worksheet, a comparison is performed to ensure that requests mapped to spreadsheet areas do not overlap other requests that you have previously mapped. If this happens, an alert message appears, indicating that certain cells are already in use.
### 5. Format Options

Lets you specify additional headings to display in the report, such as the report type, and a user-defined report name. You can also display a description of the dimensions that are present in the request, and any applied filters. See *Format Display Headers*.

### 6. Request Layout

**Column Labels, Row Labels,** and **Metrics** areas let you create your request layout. You drag metrics and dimensions to these grids, and the **Preview** window shows you what your request will look like.

<table>
<thead>
<tr>
<th>Column Labels</th>
<th>Row Labels</th>
<th>Metrics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Range</td>
<td></td>
<td>Entries</td>
</tr>
<tr>
<td>Metric Headers</td>
<td></td>
<td>Exits</td>
</tr>
</tbody>
</table>

- **6a. Column Labels:** You can add dates and metric headers as column labels.
- **6b. Row Labels:** Typically, this section is for adding dimensions. However, you can also add a date to this grid, as long as the date is the top-most item in the list. Metric headers can also be moved from the **Column Labels** section to the **Row Labels** section. As more dimensions are dropped in the **Row Labels** section, you create a breakdown report.
- **6c. Metrics:** Displays the metrics in use. The names of the metrics are included by default as **Metric Headers** in the **Column Label** grid, but you can move the items in **Metric Headers** to the **Row Labels** section.

### 7. Format

<table>
<thead>
<tr>
<th>Date Range</th>
<th>Metric Headers</th>
</tr>
</thead>
</table>

Lets you configure how to display the date. See *Format the Date*.

### 8. Filtering

<table>
<thead>
<tr>
<th>Page</th>
<th>Top 1-10</th>
</tr>
</thead>
</table>
You can create dimension filters, such as expression filters that search for specific dimension data. You can save these filters for later use. See *Filter Dimensions*.

9. Modifying

You can modify metrics to display time period averages, subtotals, and to prepend or postpend text to the cells.

10. Preview

Displays a preview of what your request will look like in Excel.

**Custom Layout**

The *Request Wizard: Step 2* dialog box lets you use the *Custom Layout* setting to configure your request. The custom layout provides most of the functionality of the pivot layout, but lets you choose where each item in the grid should be located in the spreadsheet. This layout provides the flexibility available in previous Report Builder releases, including adding breakdowns and microcharts.

This example shows the settings available when you enable the *Custom Layout* setting.
1. **Format Options**: Lets you specify additional headings to display in the report, such as the report type, and a user-defined report name. You can also display a description of the dimensions that are present in the request, and any applied filters. See *Format Display Headers*.

2. **Format**: Lets you configure how to display the date. See *Format the Date*.

3. **Filtering**: You can create dimension filters, such as expression filters that search for specific dimension data. You can save these filters for later use. See *Filter Dimensions*.

4. **Modifying**: You can modify metrics to display time period averages, subtotals, and to pre-pend or post-pend text to the cells.

5. **Range Selection**: You can use report builder select ranges of cells for you or select them manually.
Data Requests - Request Wizard Step 1

The Request Wizard: Step 1 window lets you create a data request, select a report suite, select report types, and more.

For an overview of the interface, see Request Wizard Interface.

How to create a data request

Steps to create a basic data request.

1. In Excel, click Create.
2. In the Request Wizard: Step 1 window, select a report suite.
3. (Optional) Select a segment to apply to the request. Once you have selected one or more segments, they will move to the top of the list.
   Report Builder uses segments in the same way Adobe Analytics uses them. See the Analytics Segmentation Guide.
4. (Optional) Select a publishing list to use for distribution.
5. Select a report type.
6. Specify a date range and report granularity.
7. Click Next.
8. In the Layout - Request Wizard Step 2 window, specify a layout:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pivot Layout</td>
<td>Provides a row, column, and metric grid for layout, similar to standard Excel tables. Using this layout, you can add breakdown requests within an original request.</td>
</tr>
<tr>
<td>Custom Layout</td>
<td>Provides most of the functionality of the Pivot Layout but lets you choose where each item in the grid should be located in the spreadsheet. This layout provides the flexibility available in previous releases.</td>
</tr>
</tbody>
</table>

9. On the Metrics tab, double-click (or drag) metrics in the tree to add them to the Metrics grid.
10. On the Dimensions tab, double-click (or drag) dimensions to the Row Labels grid.
    The dimensions available in Step 2 depend on the base report you selected in Step 1, and on the configuration of your report suite. The dimensions are items that correlate, sub-relate, or are a classification of the original report type metric you selected on the Request Wizard: Step 1 window. Adding more than one dimension in Step 2 is how you create a breakdown in your data request.
    See Add Metrics and Dimensions for more information.

11. Select an insertion location for the request ( ).
12. After selecting the cell, click the cell selector to return to the Request Wizard Step 2 window.
13. Continue configuring layout settings as necessary. (See Configure the Layout.)
14. On the Request Wizard: Step 2 window, click Finish to process the request.
    If you modify a spreadsheet that already contains requests, but instead of clicking Finish, you click Cancel & Refresh, report builder refreshes the edited requests already mapped to the spreadsheet before closing the Request Wizard.
Report Suites

When you first launch the Request Wizard: Step 1 window with an active workbook, or when opening a workbook containing requests, the application searches for all report suites available to you. These report suites are added to the Report Suite drop-down list.

Select a Report Suite

Steps to help you select a report suite in Excel.

1. In Excel, click Add-Ins.
2. In the toolbar, click Create.
3. In the Request Wizard: Step 1 window, select a report suite under Report Suite.

Select a Report Suite from an Existing Request in Excel

Steps to help you select a report suite from the existing request.

1. In Excel, click Add-Ins.
2. In the toolbar, click Create.
3. In the Request Wizard: Step 1 window, click the Range Selector ( ).
4. Use the Range Selection form to locate the cell.
5. Continue creating your request.

Use Excel to Locate a Report Suite ID

If you do not know a report suite’s ID, you can drag and drop the value in the Report Suite field in the Report Suite menu to a cell in your Excel workbook.

Manage Segments

How to add, edit, apply, and filter Adobe Analytics segments in Report Builder.

Report Builder features a segmentation panel in Step 1 of the Request Wizard that lets you

- Add or edit segments
- Create in-context segments
- Search for and apply segments
- Filter segments
- Add a segment control to a workbook
- Refresh the list of segments
- Manage segments across requests
Add or edit segments

💡 **Note:** To add or edit segments, the Report Builder segment interface launches the Analytics segment builder in a Microsoft Internet Explorer window. Your report builder session will stay active. Browsers other than Internet Explorer are not supported for this operation.

1. In the segment panel of Step 1 of the Request Wizard, click **Add**.
3. After you have defined and saved the segment, go back to the Request Wizard.
4. Click the Refresh icon to refresh the segment list.

⚠️ **Important:** This list is cached and your newly created segment will not appear unless you do a refresh.

Create in-context segments

You may have specific combinations of report dimensions that you would like to turn into a segment. You can create these segments from the Report Builder interface. For example, select a few pages from a Page request output, and create a segment based on these values.

1. Select the report output items you want to turn into a segment.
2. Right-click to select **Create In-Context Segment in** and specify the right container (Hits Container, Visits Container, Visitor Container).

For more information on containers, see the *Segmentation Guide*.

3. The Segment Builder UI will be now launched in Internet Explorer. The Segment Builder UI will be initialized with the container and the filter you specified.
4. After you have added a name and description to the segment, save it.
5. Go back to report builder and click the Refresh icon to refresh the list of segments.
6. You are now ready to apply this segment.
Search for and apply segments

Any segments that were created in Reports & Analytics, Ad Hoc Analysis, Report Builder, or Data Warehouse appear in this segment list. To refresh the list, click the Refresh icon.

You can apply one or multiple segments to any given request. This includes sequential segments.

1. Go to the Segment drop-down list and click the small down arrow in the Choose Segment box to display all the segments.

2. Check which segment(s) you want to apply.

💡 Note: Whether you are an Admin or a non-Admin, in Report Builder you can see only those segments that you own and those that have been shared with you. (In the Marketing Reports & Analytics user interface, the Admin can see all segments in the organization.)

Filter segments

Filter segments by clicking on the Filter icon:

Available filters include:

<table>
<thead>
<tr>
<th>Filter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tags</td>
<td>Lets you filter on segments with specific tags. Note that Tag filters use the AND operator. If you check two tags, the right pane shows segments that have been tagged with both tags.</td>
</tr>
<tr>
<td>Filter Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Owners</td>
<td>Lets you filter segments by owner. Note that Owners filters use the OR operator. If you check two owners, the right pane shows segments that are owned by either owner.</td>
</tr>
<tr>
<td>Other Filters &gt; Only report suite name</td>
<td>If you apply the &quot;Only report suite name&quot; filter in the Segment Builder in marketing reports &amp; analytics, and then display the Advanced Filter in report builder, the Advanced filter will display the segment for the selected report suite only.</td>
</tr>
<tr>
<td>Other Filters &gt; Mine</td>
<td>Shows all segments that you own.</td>
</tr>
<tr>
<td>Other Filters &gt; Shared with Me</td>
<td>Shows all segments that others shared with you.</td>
</tr>
<tr>
<td>Other Filters &gt; Favorites</td>
<td>Shows all segments you marked as Favorites.</td>
</tr>
<tr>
<td>Other Filters &gt; Approved</td>
<td>Shows all officially approved segments.</td>
</tr>
</tbody>
</table>

**Add a segment control to a workbook**

Adding a segment control lets you switch segments from within a workbook instead of having to go into the Request Wizard.

1. Click the Control icon ( ![Control Icon](image.png) ) next to the segment drop-down.
2. Check all the segments that you want to appear in the segment control, or check Select All.

3. Notice the option **Automatically refresh linked requests upon item selection**.
   - If checked, all requests that use this control are refreshed.
   - If not checked, the associated request parameters are updated, but the requests are not refreshed.

4. Specify the upper left cell location of the segment control.
5. Click **OK** and the segment control appears in the specified location.

Refresh the list of segments

Any time you add a new segment or edit an existing one, you should click the Refresh icon (🔄) to refresh the cached list of segments.
Manage segments across requests

Prior to v5.4, Report Builder let users change segments on multiple requests. However, this process always replaced the existing segments. Users who wanted to add one new segment to each request could not do this, since adding the segment would remove the previous set of segments already assigned to each request.

Report Builder 5.4 lets you add, remove, replace, and replace all segment(s) within multiple requests:

1. Select multiple requests in a workbook.
2. Right-click and select **Edit Requests > By Segment**.

![Edit Requests by Segment](image)

3. In the Edit Group dialog, select one of the four options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Segment</td>
<td>Lets you choose one or more segments to add to the list of current segment/s.</td>
</tr>
<tr>
<td>Replace Segment(s)</td>
<td>Lets you choose which segment/s to replace with one or more segment/s.</td>
</tr>
<tr>
<td>Replace All Segments by</td>
<td>Lets you choose one or more segments to replace the current segment/s with.</td>
</tr>
<tr>
<td>Remove Segment(s)</td>
<td>Lets you remove segments from the requests.</td>
</tr>
</tbody>
</table>

Allow Publishing List Overrides

When you schedule a report, you can choose a publishing list to use for distribution.

Publishing lists are set up in Analytics Admin tools.

See **Publishing List Manager** in the Analytics Reference.

To enable this feature, navigate to the **Request Wizard: Step 1** window.

If you enable **Allow Publishing List Override**, the report suite assigned to each recipient in the publishing list replaces the report suite for this request. In addition, if the workbook contains several report suites, the report suite ID associated to the publishing list is used.

This option is not available for report suites that you select from cells.

**Note:** If you send the scheduled report to multiple publishing lists, the report runs once for each list. Variable report suites are replaced by the report suite assigned to the publishing list.
Report Types

You can select the base report type for your data request, such as Site Metrics, Site Content, and Video.

You can choose only one base report type for a range of spreadsheet cells. If you are editing a previously created request, you can change the report type on the Request Wizard: Step 1 window without having to reconfigure other settings in the request.

You can search for reports using the auto-complete search bar. Once you have selected a report from this control, the tree view will automatically select the matching node.

Path and Path Fallout Reports in Report Builder

Describes how report builder supports Pathing and Fallout reports and how the implementation differs from marketing reports & analytics.

<table>
<thead>
<tr>
<th>Path Report Name in Reports &amp; Analytics (Paths &gt; dimension &gt;)</th>
<th>Supported in Report Builder?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next/Previous dimension Flow</td>
<td>Not provided as a standalone report. Can be reproduced with several requests with the Path dimension and using a filter.</td>
</tr>
<tr>
<td>Next/Previous dimension</td>
<td>Not provided as a standalone report. Can be reproduced with a Path report and using a filter.</td>
</tr>
<tr>
<td>Fallout</td>
<td>Supported and provided as a standalone report (Paths &gt; dimension &gt; dimension Fallout).</td>
</tr>
<tr>
<td>Full Paths</td>
<td>Not supported.</td>
</tr>
<tr>
<td>PathFinder</td>
<td>Not provided as a standalone report. Can be reproduced as a Path report using a filter.</td>
</tr>
<tr>
<td>Path Report Name in Reports &amp; Analytics (Paths &gt; dimension &gt;)</td>
<td>Supported in Report Builder?</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Path Length</td>
<td>Supported only for the Page dimension.</td>
</tr>
<tr>
<td>Page Analysis &gt; dimension Summary</td>
<td>Not provided as a standalone report. Can be reproduced with several requests with the Path dimension and using a filter.</td>
</tr>
<tr>
<td>Page Analysis &gt; Reloads</td>
<td>Not provided as a standalone report. Can be reproduced with a dimension report using the Reloads metric.</td>
</tr>
<tr>
<td>Page Analysis &gt; dimension Depth</td>
<td>Supported only for the Page dimension.</td>
</tr>
<tr>
<td>Page Analysis &gt; Time Spent on dimension</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Entries and Exits &gt; Entry Pages</td>
<td>Not provided as a standalone report. Can be reproduced as a Path report using the pre-defined filter Entered Site.</td>
</tr>
<tr>
<td>Entries and Exits &gt; Original Entry Pages</td>
<td>Supported only for the Page dimension.</td>
</tr>
<tr>
<td>Entries and Exits &gt; Single Page Visits</td>
<td>Not provided as a standalone report. Can be reproduced as a Path report using a pre-defined filter.</td>
</tr>
<tr>
<td>Entries and Exits &gt; Exit dimension</td>
<td>Not provided as a standalone report. Can be reproduced as a Path report using the pre-defined filter Exited Site.</td>
</tr>
</tbody>
</table>

Filtering a Path Report Using the Request Wizard

Describes the steps involved in applying filters to a pathing report.

This example uses Site Section Paths.

1. In Adobe Report Builder, click **Create** to open the Request Wizard.
2. Select the right report suite.
3. In the tree view on the left, select **Paths > Site Sections > Site Section Paths**.
4. Specify the appropriate date/s.
5. Click **Next**.
6. In Step 2 of the Wizard, under **Row Labels**, click the **Top 1-10 (pattern applied)** link. In a path report, a pattern is applied by default.

7. Select the **Filter** option.

8. In the **Define 'Site Section Paths' Path Pattern** dialog, you can specify
   a) the starting rank of the first report.
   b) the number of entries you want displayed in this report.

9. Click **Edit** to define a path pattern.

10. If you want a custom pattern, drag and drop any **Pattern Objects** from the list on the left into the **Pattern Build Canvas** on the right.

11. You can also select a predefined pattern from the **Select a Pattern** drop-down list and modify it. Here are the available patterns:
Some of these patterns are specific to report builder: Entry Path's Next Item Pattern, Exit Path's Previous Item Pattern, Next Item Pattern.

12. To edit a predefined pattern,
   a) Select it. For example, select the **Exited Site Pattern**:

   ![Exited Site Pattern](image)

   b) Now you should define the site section path that the user follows before exiting. Click **Specific Item(s): 0 selected**. You can define this path by selecting from a range of cells (if you are editing an existing request) or by selecting from a list of sections.

   c) To select from a range of cells from a previous request, select **From range of cells** and click the cell selector icon. Then pick the cells from the report.

   ![Select Range](image)

   d) To select from a list of site sections, select **From list** and click **Add**.

   e) Move elements from the **Available Elements** column to the **Selected Elements** column by selecting them and clicking the orange arrow. The click **OK**.
f) To save the pattern you just established, click **Save**.
g) Click **OK** three times and then click **Finish**. The filtered path request now gets generated.

**Filtering a Fallout Report Using the Request Wizard**

Describes the steps involved in applying filters to a fallout report.

This example shows the Page Fallout report.

1. In Adobe Report Builder, click **Create** to open the Request Wizard.
2. Select the right report suite.
3. In the tree view on the left, select **Paths > Page > Page Fallout**.

4. Configure the appropriate **date ranges**.
5. Click **Next**.
6. In Step 2 of the Wizard, under **Row Labels**, click the **Define Checkpoints** link. (In a fallout report, you always have to define path elements, unlike in a path report, where a pattern is pre-applied.)

7. Select the **Filter** option.
8. In the **Define Site Section Fallout Checkpoints** dialog, define checkpoints from a range of cells or from a list. Then click **OK**.

9. Decide whether to select from a range of cells or from a list.

10. If you select from a list, click **Add** to select checkpoints to add to the fallout path. You can define between 3 and 8 checkpoints. (Search for available elements by clicking **More**.)

    For more information on refining the filter, see **Filter Dimensions**.

11. Move **Available Elements** from the left column to the right by selecting them and clicking the orange arrow.

12. Click **OK** three times, then click **Finish**.

    The report should refresh now.

---

**Filtering Path Reports by Adding Dependent Requests**

Describes how to create path reports with predefined filters.

Marketing Reports & Analytics offers a few standalone reports that are top path reports with predefined filters, such as **Next** and **Previous Site Section** reports, **Entry** and **Exit Site Section** reports, and **Single Site Section** report.

Report Builder does not offer these as standalone reports, but you can create them through the **Add dependent request** > **Path** context menus. The following reports are available:

- Path > Page Fallout
- Path > Entry Path
- Path > Exit Path
- Path > Next Page
- Path > Entry Path > next Page
- Path > Previous Page
- Path > Exit Path > Previous Page
- Path > Entry Path > As Entry Page
- Path > Exit Path > As Exit Page

1. Select multiple rows from an existing request, then right-click **Add Dependent Request** > **Path**.

    (Note that you have to select at least 3 rows if you want to see the **Page Fallout** menu item.)
2. Select the predefined filter, for example **Previous Page**.
   The Request Wizard appears, with the Previous Page metric already selected.
3. Continue to refine your request in the Request Wizard and generate your request.

**Select a Report Type**

Steps to select the base report type for your data request.

1. Navigate to **Request Wizard: Step 1** window.
2. Select a report suite from the **Report Suite** menu.
3. Choose the base report type for your data request.

**Import Bookmarked Reports and Dashboard Reportlets**

All bookmarked reports and dashboard reports are now listed as dimensions in the Request Wizard Step 1 and can be imported as report builder requests.

When you select a bookmarked report, the Request Wizard populates all the dimensions and metrics that define this bookmarked report. The date range, granularity and selected segment are also updated based on the selected bookmark.

This is how the Request Wizard Step 1 shows a dashboard and its reportlets:
When you click **Retrieve your Dashboards** or **Retrieve your Bookmarks**, your existing dashboard and/or bookmark data is retrieved and pasted in the worksheet.

*Note: In Report Builder, the list of available dashboards and bookmarks is limited to the user but also to the ones that apply to the report suite you selected in Step 1 of the wizard. By contrast, in marketing reports & analytics, you are given access to all bookmarks and dashboards that are accessible to you, regardless of which report suites these dashboard and bookmarks use.*
**Note:** Only data is imported, so if the bookmark contains a chart, or if the dashboard reportlet consists of only a chart, only the data that is used to populate the chart is imported.

Once you have created a request by importing a dashboard reportlet (or a bookmark), the request will then be associated to the reportlet's (or bookmark's) primary dimension. As a result, if you edit the request, the tree view no longer selects the dashboard reportlet tree view node (or bookmark node): it selects its primary dimension instead.

The imported bookmarklet will properly set the report suite, selected segment, dimension and selected metrics to the same parameters exposed in the Reports & Analytics bookmark.

**Important:** The date range will be set to the same date range, but as a static date range - even if this date range was a rolling date range in the Reports & Analytics bookmark.

## Date Ranges

The date range defines the time span covered by requests you create. Several types of request time periods are available, such as preset, fixed, and rolling. The maximum number of periods is 366. You can also choose a date range specified by a cell. You can save a request date range if it does not contain reference from cell values.

### Preset Dates

Preset dates let you select commonly used dates or dates you have saved.

On the Request Wizard: Step 1, choose **Preset Dates**.

#### Request Wizard Definitions - Preset Dates

Field definitions for preset dates in report builder.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commonly Used Dates</td>
<td>Displays the most frequently used date ranges. This setting is enabled by default when you create a new request. If there is at least one request in the workbook, report builder uses the date of the existing request as the default setting.</td>
</tr>
<tr>
<td>Saved Date Templates</td>
<td>Displays the date range templates that the current user has created. You can save dates on the <strong>Fixed Dates</strong> form. If you saved a date template for use with all report suites, you must enable <strong>Show Saved Date Templates for All Report Suites</strong> in order to select it. See <a href="#">Fixed Dates and Saved Date Ranges</a> for more information.</td>
</tr>
<tr>
<td>Show Saved Date Ranged for All Report Suites</td>
<td>Displays templates that have been made available to all report suites. Click <strong>Edit</strong> to manage saved date ranges or to rename the currently selected saved date range. See <a href="#">Fixed Dates and Saved Date Ranges</a> for more information.</td>
</tr>
</tbody>
</table>
Fixed Dates and Saved Date Ranges

When you specify a fixed date or date range, report builder displays the reporting calendar, which lets you select a date, a date range, or a preset date. You can also save a fixed date to use as a template, and specify whether the saved dates are available for the current report suite or for all report suites.

1. On the Request Wizard: Step 1, choose **Fixed Dates**.
2. Click the date link.
3. Select a date, then click **OK**.
4. To save a date range, click **Save Date**.
5. Configure the options on **Save Date Range** form:

---

**Request Wizard Definitions - Fixed Dates**

Definitions for fixed dates in report builder.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>This Report Suite</td>
<td>Makes the saved date range available for only the current report suite.</td>
</tr>
<tr>
<td>All Report Suites</td>
<td>Makes the saved date range available for all report suites accessible by the logged-in user.</td>
</tr>
<tr>
<td>Enter Parameter Name</td>
<td>Type a name for your saved date. You can use this date as a template in report builder. This name is displayed wherever you can apply a saved date. Changing the name of a template does not affect the date configuration used in previously created data requests.</td>
</tr>
</tbody>
</table>

---

**Rolling Dates**

Steps that describe how to customize a rolling date for your request.

1. On the **Request Wizard: Step 1**, select **Rolling Dates**.
2. Click the **Rolling** link to choose the rolling type, then use the date links to configure rolling dates.
   - The settings for **Rolling Dates** change depending on your selections. For example, when you select **Rolling Weekly**, report builder provides week-specific settings you can select as the rolling pattern.
3. Configure advanced options as desired.

---

**Request Wizard Definitions - Rolling Dates**

Field definitions for rolling dates in report builder.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize Expression</td>
<td>See <strong>Customized Date Expressions</strong>.</td>
</tr>
</tbody>
</table>
### Definitions

<table>
<thead>
<tr>
<th>Fields</th>
<th>Definitions</th>
</tr>
</thead>
</table>
| As of Date      | The date reference to use for the rolling range. Values are:  
|                 | • Specified at run-time: Lets you enter a date each time the request is run.  
|                 | • Anchored from cell: Lets you set the date reference from a cell value.                                                                   |

### Real-Time Reports

Displays web page traffic and ranks page views in real time, so that you can more quickly understand what is trending on your site.

For real-time reporting, Analytics uses high-frequency metrics and site analytics to visually report traffic and page view trending of dynamic news and retail web sites. Real-time understands trends in your data from minute to minute, within seconds of collection. It collects and streams data to the interface, using real-time correlation and tracking of content and some conversion.

You can:

• Create up to three real-time reports per report suite, using existing metrics, dimensions, and classifications. Use the secondary dimensions to correlate with (or break down) the primary one.
• Add three dimensions (or classifications) per report (one primary and two secondary), in addition to site-wide metrics.
• Use any custom event, shopping cart event, or instance.
• View up to 20 hours of historical, real-time data.

Real-time respects permissions for users and groups. For example, if you do not have rights to see revenue, you cannot view a real-time report that includes revenue data. eVars (conversion metrics) are not supported. Real-Time permissions are enabled in the Admin Tools.

*Note: Real-Time Reports are not the same as the Include Current Data (Data Recency) feature released previously, which reduced latency for standard reporting, by displaying data before it is finalized.*

### Configure a real-time request

Steps that describe how to configure real-time request dates.

1. Ensure that real-time reporting is enabled in the Admin Tools in marketing reports & analytics.
2. On the Request Wizard: Step 1, click Real-Time Report > <report type>
   
   For example, select a Traffic Report. When you select a real-time report type, the Select Time Range options display.
3. Select a time range in minutes or hours.
Real-time reporting is available only for the last 20 hours. For granularity, you have options of selecting from 1 minute granularity to 30 minutes.

4. Click **Next** and continue configuring the request layout.

### Customized Date Expressions

You can specify a complex date range by building a custom expression.

It is recommended that you refer to a calendar when building expressions in order to specify the number of weeks and days correctly. Excel has several built-in functions allowing you to calculate the number of days, workdays, months, and years between dates. You can use these functions in formulas to calculate other intervals, such as weeks and quarters.

**To enable custom expressions**

1. On the **Request Wizard: Step 1**, select **Rolling Dates**.
2. Enable **Custom Expression**.
3. Type a special expression in the **From** and **To** fields, following the abbreviations, syntax rules, and examples given below.

The following topics provide more information about customized date expressions:

#### Date Abbreviations

Time abbreviations refer to a particular date when a period begins, not a range of days. A range of days is expressed by specifying a start and an end date for two time abbreviations (or terms).

For information about using proper syntax, see *Syntax Notes*.

- cd = current date (today)
- cw = current week (first day of the current week)
- cm = current month (first day of current month)
- cq = current quarter (first day of current quarter)
- cy = current year (first day of current year)

In the following list, *[UNIT]* indicates any integer multiplier.

- *[UNIT]*d = day
- *[UNIT]*w = week
- *[UNIT]*m = month
- *[UNIT]*q = quarter
• [UNIT] y = year

Individual Starting or Ending Dates

Abbreviations for starting and ending dates.
• cd-1d = yesterday
• cm-1d = last day of last month
• cw-1w = first day of last week
• cw+1w-1d = last day of the current week
• cd-2d = two days ago
• cw-2w = first day the week, two weeks ago

Note that setting the date to a future date does not return values for future dates.

Examples of Date Ranges Using Customized Expressions

Examples, notes, and syntax notes about using date ranges in customized expressions.

The table assumes that today's date is Monday, November 10, 2011, using the Gregorian calendar.

<table>
<thead>
<tr>
<th>Example</th>
<th>Date Range</th>
<th>Customize Expression</th>
<th>Date Range of Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Two weeks ago</td>
<td>cw-2w</td>
<td>26 Oct to 1 Nov</td>
</tr>
<tr>
<td>2</td>
<td>First 3 days of the fifth month of last year</td>
<td>cy-1y+4m</td>
<td>1 May to 3 May 2010</td>
</tr>
<tr>
<td>3</td>
<td>One full week, starting 4 weeks ago</td>
<td>cw-4w</td>
<td>12 Oct to 18 Oct</td>
</tr>
<tr>
<td>4</td>
<td>Last week in the previous year</td>
<td>cw-53w</td>
<td>Nov to 9 Nov 2010</td>
</tr>
<tr>
<td>5</td>
<td>One month starting 2 months ago</td>
<td>cm-2m</td>
<td>1 Sept to 30 Sept</td>
</tr>
<tr>
<td>6</td>
<td>12 months ago in the previous year</td>
<td>cm-12m</td>
<td>1 Nov to 30 Nov 2010</td>
</tr>
</tbody>
</table>

Notes on Examples

Example 1

If today is Monday, November 10, 2011, take the current date and subtract one week to obtain the last full week of October.

Example 2

Add four months to the beginning of the year (the month of January) to get the month of May; add two days to the first day of the month to get the third day of the month.
Syntax Notes

Customized expressions covering most date ranges can be created by linking two terms with an operator. A term is a combination of an integer multiplier and a period abbreviation. An example of a term is 18d. An example of an operator is +.

- White space is not allowed between operators and terms.
- Use only these abbreviations: cd cw cm cq cy d w m q y
- The best practice is to use the same date reference in the start date and in the end date: cd, cd, or cw, cw, or cy, cy. Mixing date references can lead to invalid dates at certain times of the year.
- Valid multiples of the abbreviations d w m q y are formed by means of integers (1 2 3 ...) prepended to the abbreviation, such as 53d 3w 5q 9m 2y
- Non-integer numbers are not allowed.
- Do not prepend the abbreviation with only a zero. For example, 0w is not allowed.
- The following operators are used to concatenate abbreviations: + -
- Because date ranges must be reckoned relative to the current period, the first term in an expression always begins with c.

Considerations

Two important considerations when using the Customize Expression to set the date range:

- The day the report (As Of) is run (or requests refreshed) determines what data is available.
- The rollover of start and end dates of the report affects the date range covered by the report.

Because the availability of data is sensitive both to the time frame of the report and the date that you refresh requests in the report, ensure that you run the report on the appropriate day to extract the desired information. The examples below demonstrate both of these considerations.

Assume you make a request for Page Views using Aggregated granularity. In North America, the week begins on Sunday. To obtain updated reports for the period Sunday to Saturday (for example, November 23 to November 29, 2008), run the report (refresh requests) on Sunday (November 30) for the previous week (11/23 to 11/29).

Use this customized expression:

\[ \text{From: cw-1w} \quad \text{To: cw-1d} \]

An analysis of the customize expression when the inclusive End Date for the request is 11/30:

\[ \text{From: cw-1w} \]
the day of the current week starting on Sunday, November 30 minus seven days = the day of the past week starting on Sunday, November 23

\[ \text{To: cw-1d} \]
the day of the current week starting on Sunday, November 30 minus one day = Saturday, November 29

After the customized expression is mapped to the spreadsheet, refresh the request using Sunday, November 30, 2008 as the inclusive End Date for the floating request. The data will reflect the week-long period.

If instead you refresh the expression and specify Saturday, November 29 as the End Date for the floating request, the data will reflect the week 11/16 to 11/22. This is because the reference date for the request refresh is one day earlier.
Here are the differences when the inclusive **End Date** for the request is 11/29:

*From:* cw-1w

the day of the current week starting on Sunday, November 23 minus seven days = the day of the past week starting on Sunday, November 16

*To:* cw-1d

the day of the current week starting on Sunday, November 23 minus one day = Saturday, November 22

In Europe and some other countries, the week begins on Monday, rather than Sunday. In this case, you can customize the calendar to change the start date. (See *Custom Calendar*.)

**Dates from a Cell**

You can specify a date range by selecting cells from a worksheet that contains a request. Report builder uses the specific date range information in those requests. If you select today's date, you see partial data based on the time of day the request runs.

**To configure dates from a cell**

1. On the **Request Wizard: Step 1**, select **Dates From Cell**.
2. Enter cell references in the **From** and **To** fields, or click the selector and select the cells containing the requests with the starting and ending dates.

**To set a fixed starting date and a rolling end date**

For example, create a Report Builder request with the date range set to “yesterday” and output the request date in the same cell as “today()-1”.

**Granularity**

On the **Request Wizard: Step 1**, you can apply a level of granularity to the data request. Granularity specifies the level of time-based detail that is included in the report.

Valid values are Hour, Day, Week, Month, Quarter, Year, and Aggregated.

**How Report Builder Processes Granularity**

Suppose you choose a date range for a month with **Month** granularity. Requests show totals for the metric based on exactly one month's worth of data. If the date range of your request spans one quarter, the report shows three figures: one for each month unit, or fraction thereof. If today is March 18, choosing the last quarter returns one figure for January 1 - January 31, another figure for February 1 - February 28, and a final figure for March 1 - March 17.

**Custom Calendar**

Report builder uses the Analytics custom calendar. You can use the calendar to define the first day of the week and year, or use a different retail calendar style. The calendar formats are used to for various purposes, including sales comparison and forecast standardization, payroll cost analysis, or physical inventory count regulation.

Each of the calendar formats is described below.
<table>
<thead>
<tr>
<th>Calendar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gregorian Calendar</td>
<td>Uses the traditional calendar format (January through December, with 30 or 31 days and a variable number of weeks in each month).</td>
</tr>
<tr>
<td>Modified Gregorian Calendar</td>
<td>Uses the Traditional Gregorian Calendar but enables you to select the first month of the year and first day of the week.</td>
</tr>
<tr>
<td>4-5-4 Retail Calendar</td>
<td>Breaks down each month by the number of weeks in the month. Meaning, January has four weeks, and so on. The National Retail Federation uses the 4-5-4 calendar format.</td>
</tr>
<tr>
<td>Custom Calendar</td>
<td>Offers three formats based on the number of weeks in each month. The number of weeks in each month depends on the selected first day of the year.</td>
</tr>
<tr>
<td></td>
<td>A year has 52 weeks. Divide that into 4 quarters and you get 13 weeks per quarter. But there are 3 months in a quarter. 13 is not divisible by three so you end up putting the extra week into one of the months so that it's always consistent. 5/4/4 means the 1st month of the quarter has the extra week. 4/5/4 means the 2nd month has the extra week, etc. In the 5-4-4 calendar, the 53rd week is added onto the last quarter of the year.</td>
</tr>
<tr>
<td></td>
<td>• <strong>4-5-4</strong>: January has four weeks, February has five weeks, March has four weeks, and so on.</td>
</tr>
<tr>
<td></td>
<td>• <strong>4-4-5</strong>: January has four weeks, February has four weeks, March has five weeks, and so on.</td>
</tr>
<tr>
<td></td>
<td>• <strong>5-5-4</strong>: January has five weeks, February has five weeks, March has four weeks, and so on.</td>
</tr>
<tr>
<td>Note:</td>
<td>This calendar option is supported across all Adobe Analytics tools (Analysis Workspace, Reports &amp; Analytics, Report Builder, Activity Map, Ad Hoc Analysis) except for Data Warehouse, which does not support custom calendars.</td>
</tr>
</tbody>
</table>

**Interactive Controls**

Interactive Controls allow you to edit segments and date ranges for one or more requests directly from the worksheet. This gives you more flexibility when updating report builder requests.

Interactive controls were created in response to a common workflow where analysts create workbooks and share these workbooks with the marketing organization. Interactive controls give marketers the ability to modify and refresh requests without having to have in-depth knowledge of how report builder works. (Note that in order to refresh a request, the workbook recipient must be a report builder user.) These controls work inside of scheduled workbooks. Two types of interactive controls are currently available:

- **Rolling Date Range**
- **Segments**
**Important:** You must have Report Builder v5.0 installed for the interactive controls to work.

- If you are running Microsoft Excel on Windows but are running a lower version of report builder, or if you do not have report builder installed: You can change the value in the interactive control, but it will not refresh the associated request, nor update the request’s associated parameters.
- If you are running Excel on Mac, changing the value in the control will cause the following message to be displayed: “The macro ‘Adobe.ReportBuilder.Bridge.FormControlClick.Event’ cannot be found.”

**Important:** Do not tamper with the name of the control. (To see the name, set the focus on the control and the control name appears right above the Excel grid, in the upper left corner.)

### Implement Interactive Date Range Control

1. In Step 1 of the Request Wizard select, for example, the **Page** report.
2. Next to the **Commonly Used Dates** drop down, click the **Control Settings** icon:

![Control Settings Icon](image)

3. In the Control Settings dialog, select all the date range items that you want displayed in the interactive control. In addition, specify the upper left cell location of the control.

![Select Date Range](image)

![Select Cell Location](image)

4. Notice the option to "Automatically refresh linked requests upon item selection".
   - If checked, all requests that use this control are refreshed.
   - If not checked, the associated request parameters are updated, but the request is not refreshed.
5. Click **OK**. The control appears in the cell location that you specified:

![Interactive Segment Control](image)

6. You can now change the date range and the request will refresh with that date range.

7. You can also copy the request and right click to use one of two Paste Request options:
   - **Paste Request > Use Absolute Input Cell**. This means that the copied request will point to the same interactive date range control as the original request.
   - **Paste Request > Use Relative input Cell**. This means that the copied request will point to its own control.

   **Note:** You can use the native Microsoft Excel Cut/Copy/Paste control functionality. Report builder automatically recognizes the newly added controls.

**Implement Interactive Segment Control**

Implementing the interactive segment control is similar to implementing the date range control.

1. In Step 1 of the Request Wizard, next to the **Segment** drop-down list, select the Segment Control Settings icon:

   ![Segment Control Settings](image)

2. In the Segment Control Settings dialog, select the segments you want to include in the drop-down. In addition, specify the upper left cell location of the control.
3. The new interactive control will now appear in the workbook:
Layout - Request Wizard Step 2

The Request Wizard: Step 2 window lets you configure the report layout, header formatting, and dimension filtering for output. You can use a Pivot Layout to configure the request, which is similar how you create an Excel pivot table.

Alternatively, you can manually select the cells in which you want to display report data by using the Custom Layout.

Metrics and Dimensions

You can add metrics and dimensions to the Request Wizard: Step 2 to define the analytics layout of the data in your request. The list of metrics and dimensions in report builder follow the menu layout displayed in Reports and Analytics.

Metrics are numeric values. They consist of quantitative information about activity on your website, such as Page Views, Visitor Profile, Click-throughs, Reloads, Average Time Spent, Date, Units, and so on. Report builder organizes metrics in several groups, which follow standard grouping in marketing reports and analytics:

• Standard Traffic: Displays the metric based on the line item specified. For example, in a Pages report, the Visits metric displays the number of visits to that specific page.
• Standard Commerce: Metrics such as Revenue, Orders, and Checkouts.
• Total metrics: Displays the metric based on the reporting date range, regardless of line item. This metric is identical to the total at the bottom of its respective analytics report.
• Participation
• Calculated
• Lifetime

Dimensions are non-numeric values and dates, such as gender, month, age, loyalty, monitor resolution, and so on. Dimensions are descriptions or characteristics of metric data that can be viewed and compared, such as in breakdown reports.

Calculated Metrics

Report Builder 5.2 supports Adobe Analytics Unified Calculated Metrics. Among other innovations, all calculated metrics now have a global ID - they are no longer restricted to one report suite.

💡 Note: Existing workbooks might point to requests with legacy metric IDs. When you use Report Builder 5.2, these legacy metric IDs will be converted to the new global ID. If you share this workbook with a user of Report Builder v5.1 or earlier, that user will not be able to see the calculated metrics.

To find out more about how to create and manage calculated metrics with the new Calculated Metric Builder and Manager, refer to the Calculated Metrics Guide.

In Step 2 of the Request Wizard, you can filter and apply calculated metrics.

Filter Calculated Metrics

Filter calculated metrics by clicking on the Filter icon: ⬇️. The Advanced Filters dialog is populated with both standard and calculated metrics.

Available filters include:
### Filter Name | Description
--- | ---
Tags | Lets you filter on calculated metrics with specific tags. Note that Tag filters use the AND operator. If you check two tags, the right pane shows metrics that have been tagged with **both** tags.
Report Suites | If you apply the "Only report suite name" filter in the Calculated Metric Builder in Reports & Analytics, and then display the Advanced Filter in Report Builder, the Advanced filter will display the calculated metrics for the selected report suite only.
Owners | Lets you filter metrics by owner. Note that Owners filters use the OR operator. If you check two owners, the right pane shows metrics that are owned by **either** owner.
Other Filters > Approved | Shows all officially approved metrics.
Other Filters > Favorites | Shows all metrics you marked as Favorites.
Other Filters > Mine | Shows all metrics that you own.
Other Filters > Shared with Me | Shows all metrics that others shared with you.

### Apply Calculated Metrics
After you have selected the filters, click **Apply** to apply them to your request. The selected metric(s) are now added to the report layout.
Combine Traffic and Commerce Metrics in the same Request

You can now combine these two metric types in one and the same request, instead of having to create separate requests.

Traffic and commerce metrics are now displayed in the same metric category in Step 2 of the Request Wizard. Previously, these metrics were separated into a Commerce category and a Traffic category.

The new grouped category is labeled **Standard**...
User Access Permissions for Dimensions and Metrics

Adobe Report Builder now features permissioning settings analogous to those in the Analytics Admin Tools.

As a non-Admin user, you may have previously created workbooks with requests that point to dimensions and metrics that you do not have access to. These permissions are now enforced.

For example, if you refresh a request that includes dimensions or metrics to which you have no access, you will get a Restricted Permission Error:
Follow these instructions for each Report Builder workbook that you maintain:

1. Open the workbook.
2. Refresh all requests.
3. If you get prompted with a User Access Permission error, click Open CSV File to get access to the list of restricted permissions errors.
4. Create a file “AllRestrictedPermissionErrors.xlsx” and copy/paste the list of restricted permission errors form the CSV file into this file.

Once you have processed all workbooks, you should have a comprehensive list of restricted permission errors in “AllRestrictedPermissionErrors.xlsx”. Send this list to your Adobe Analytics user access administrator, asking him to grant you access to the metrics and dimensions.

**Add Metrics and Dimensions**

Steps to add metrics and dimensions to a request.

1. *Create the data request* on the Request Wizard: Step 1, then click Next.
2. On the Request Wizard: Step 2, double-click metrics, or drag them to the desired position.
When you add metrics, they are not removed from the Metrics tab, because you can display metrics multiple times within a request. For example, you can display the metric subtotal in addition to each value. However, the list of available metrics changes each time you add or remove a dimension.

You can add only metrics to the Metrics layout section. Metrics are added to the Column Label layout as a Metric Header. If you move a Metric Header from Column Layout to Row Layout, it is displayed there and is used as a metric as a breakdown.

Note that a Search bar is shown on the Metrics tab, just above the Metric list.
Keep this in mind:

- As you enter a search term, the list will automatically update to only display the metrics whose label matches the search term.
- The match is case insensitive, and equivalent to a “contains” search.
- Full-word searches, or other special search flag (starts with, ends with, AND, OR, etc.) are not supported.

The Search term will be cleared if you exit the Request Wizard (i.e., click Finish or Cancel), or go back to Request Wizard Step 1, or change the Metric category.

The Search term will not be cleared in the following cases:

- You drag and drop (or double click) one of the metric item from the list so it gets added to the Pivot Layout/Custom Layout Metrics Panel.
- You remove a metric item(s) from the Pivot Layout/Custom Layout Metric Panel.
- You click the Dimension tab, then return to the Metric tab.
- You invoke other sub forms (modal or modeless) that upon exit will return to the Request Wizard Step 2. Examples of these forms are
  - Dimension Filter Forms
  - Date Range Formatting Forms
  - Format Options Form
  - Prepend-Postpend Text Form
  - Output Range Location Form

3. (Optional) To sort a request by metric, just click the metric label.
4. Add dimensions the same way you add metrics.

On the Dimensions tab, the system displays dimensions that break down or are a classification of any base report you select on Step 1, and on the configuration of the report suite. When you drop a dimension to the layout grids, it is removed from the tree view and recalculates the list of remaining dimensions available.
The **Date** dimension is added automatically. Available date dimensions change depending on the selected granularity from the **Request Wizard: Step 1**. (See **Date Ranges**.) Valid values are:

- Hour
- Day
- Week
- Month
- Year
- Date range (when no granularity is specified)

5. Modify metrics and dimensions by configuring *format options* and filters.

6. Click **Finish**.

In the following example, dimensions relate to the **Page** metric. Here, the **Referring Domain** dimension creates a breakdown report between **Page** and **Referring Domain**. The **Dimension** tab is updated with only dimensions that you can add to a breakdown report.

---

**Modify Metrics - Field Definitions**

Field descriptions for configuring metrics in Report Builder.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subtotal (this request)</td>
<td>The subtotal of the response received from the server. Meaning, it provides the total number of items for line item metrics over a date range selected according to the elements you specify. When you click this option, data for all items with the specified starting rank and number of entries is totaled. This option is available only if you have selected a metric that you can aggregate. Subtotals presented still depend on any other criteria or filter you set in step 2 of the Request Wizard. A suggested use of Subtotal (this request) is in combination with filtering.</td>
</tr>
<tr>
<td>Average</td>
<td>Averages the item by day, week, or month. You can also specify none. For example, if you select the Paths metric and map the names of the paths to the spreadsheet, you can choose to display the number of visits to the content path for a given time period as either the raw data (actual number of visits / time period), or as an average (number of visits / time period) per day, per week or per month.</td>
</tr>
<tr>
<td>Prepend Text</td>
<td>Adds a prefix of numeric or string values in the cell.</td>
</tr>
<tr>
<td>Postpend Text</td>
<td>Appends a numeric or string values in the cell.</td>
</tr>
</tbody>
</table>

**Customer Attributes**

Customer attributes are stored in new type of element called VisAttr, which can be configured as a dimension or a metric.

For more detailed information on how to upload customer attributes, see the [Experience Cloud help](link).

- If it's configured as a metric, VisAttr is exposed both as “dimension” and metric.
• It supports the same breakdown as an eVar (anything can be broken down by anything).
• VisAttr supports all eVar metrics.
• VisAttr as a metric supports “bucketization” (like Time Spent on Site: 0 to 30, 31 to 60, …)
• VisAttr is available as a segmentation dimension.
Anomaly Detection

Anomaly detection uses statistical modeling to automatically find unexpected trends in your data. The model analyzes metrics and determines a lower bound, upper bound, and expected range of values. When an unexpected spike or drop occurs, the system alerts you in the report.

Examples of anomalies you might investigate include:

• Drastic drops in average order value
• Spikes in orders with low revenue
• Spikes or drops in trial registrations
• Drops in landing page views
• Spices in video buffer events
• Spikes in low video bit-rates

Note: Anomaly detection is available only when you select the Day granularity.

Anomaly Detection Metrics

Anomaly detection adds new metric values for each metric you select, including:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower Bound</td>
<td>Lower level of the prediction interval. Values below this level are considered anomalous. Represents a 95% confidence that values will be above this level.</td>
</tr>
<tr>
<td>Expected</td>
<td>The predicted value based on the data analysis. This value is also the middle point between the upper and lower bounds.</td>
</tr>
<tr>
<td>Upper Bound</td>
<td>Upper level of the prediction interval. Values above this level are considered anomalous. Represents a 95% confidence that values will be below this level.</td>
</tr>
</tbody>
</table>

Report builder applies these values to selected metrics. For example, if you select a Page Views metric and apply anomaly detection, a Page Views Lower Bound metric is used.

How Anomaly Detection Is Calculated

Anomaly detection uses a training period to calculate, learn, and report prediction interval data per day. The training period is the historical period that identifies what is normal vs. anomalous, and applies what is learned to the reporting period. In marketing reports, training periods of 30, 60, and 90 are available. In report builder, 30 days are available.

The training period is not necessarily the same as the selected reporting period. A report graph displays the date range period you specify in the calendar.

To calculate the data, the daily total for each metric is compared with the training period using each of the following algorithms:

• Holt Winters Multiplicative (Triple Exponential Smoothing)
• Holt Winters Additive (Triple Exponential Smoothing)
• Holts Trend Corrected (Double Exponential Smoothing)
Each algorithm is applied to determine the algorithm with the smallest Sum of Squared Errors (SSE). The Mean Absolute Percent Error (MAPE) and the current Standard Error are then calculated to make sure that the model is statistically valid.

These algorithms can be extended to provide predictive forecasts of metrics in future periods.

Because the training period varies based on the start of the reporting period, you might see differences in the data reported for the same date as part of two different time periods.

For example, if you run a report for January 1-14, and then run a report for January 7-21, you might see different prediction data for the same metric between January 7-14 in the two different reports. This is a result of the difference in training periods.

<table>
<thead>
<tr>
<th>Reporting Range</th>
<th>Training Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1-14</td>
<td>November 27 - December 31</td>
</tr>
<tr>
<td>January 7-21</td>
<td>December 4 - January 6</td>
</tr>
</tbody>
</table>

Configure an anomaly detection request

Steps that describe how to create an anomaly detection request in report builder.

1. Select a trended report, such as a **Site Metrics > Traffic** report.
2. In the **Apply Granularity** menu, select **Day**.
   
   **Note:** The **Anomaly Detection** menu is available only when you select Day granularity. The previous 30 days of data is used as the statistical data training period, regardless of the date range you select.

3. After configuring date ranges, click **Next**.
4. On the Request Wizard: Step 2 of 2, add a metric, such as **Visits**.
5. For the added metric, click the **None** link.

6. Select **Anomaly Detection > <selection>**.
When you select one of these options, the system creates Anomaly Detection copies of the original metric. For example, for the Visit metric, a Lower Bound Visit metric is added to the Metric group.

7. Click **Finish** and select the cell for output to Excel.

See [Anomaly Detection](#) for definitions.

### Format the Date

In addition to the standard cell formatting choices available through Excel's **Format > Cells** (Ctrl+1) feature, you can apply limited formatting to cell ranges with report builder. These formatting choices depend on the metric you have chosen.

After you **add dimensions** to the Row Labels grid, click **Format**.

In the **Format** menu, click **Custom Format** to apply customized formats for dates similar to the prepend and postpone feature. For example, you can enter text that always occurs after the date (such as A.D. B.C.E. A.H. etc.). You can add text before the date, such as **Start Date** and **Start and End Date**. In addition, you can construct a custom date expression from day, month, and year abbreviations, and use a custom separator between parts of the date. All date formats must consist of three abbreviations only enclosed in brackets.

The following table describes how you can use date abbreviations in the **Custom Format** field:
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Meaning</th>
<th>Example using Wednesday, March 14, 2012</th>
</tr>
</thead>
<tbody>
<tr>
<td>MM/dd/yyyy</td>
<td>Full numeric date</td>
<td>03/14/2012</td>
</tr>
<tr>
<td>M</td>
<td>Number of month</td>
<td>3</td>
</tr>
<tr>
<td>MM</td>
<td>Number of month with 0 padding for months &lt; 10</td>
<td>03</td>
</tr>
<tr>
<td>MMM</td>
<td>Short name of month</td>
<td>Mar</td>
</tr>
<tr>
<td>MMMM</td>
<td>Long name of month</td>
<td>March</td>
</tr>
<tr>
<td>D</td>
<td>Long name of the date</td>
<td>Wednesday, March 14, 2012</td>
</tr>
<tr>
<td>d</td>
<td>Number of day</td>
<td>14</td>
</tr>
<tr>
<td>dd</td>
<td>Number of day with 0 padding for days &lt; 10</td>
<td>01 - 09</td>
</tr>
<tr>
<td>ddd</td>
<td>Short name of day</td>
<td>Wed</td>
</tr>
<tr>
<td>dddd</td>
<td>Long name of day</td>
<td>Wednesday</td>
</tr>
<tr>
<td>yy</td>
<td>2-digit year</td>
<td>10</td>
</tr>
<tr>
<td>yyyy</td>
<td>Full 4-digit year</td>
<td>2012</td>
</tr>
</tbody>
</table>

**Format Display Headers**

You can name your report and configure how to display row and column headers. The **Format Options** link is available for the **Pivot** and **Custom Layout** types.

1. Create a request on the **Request Wizard: Step 1**.
2. Click **Next**.
3. On the **Request Wizard: Step 2** form, add dimensions and metrics data to the request, as desired.
4. Click **Format Options**.
5. Configure the **Display** options:

   **Element** | **Description**
   ---------- | ------------------
   Report Name | Displays either the name of the report type you selected from the tree in the **Request Wizard: Step 1** (for example, **Traffic Report**), or the name you type in the **Name this Request** field.
   Filters Parameters | Displays the dimension filters, such as a search filter.
   Segment | Displays the segment parameter.
   Data Recency | Displays data recency parameters. For example:
   
   **Data Recency:** Page Views (1.5 hr ago), Exits (30 mins ago)
   
   See **Report Builder Options** for information about current data processing.
Regarding display order, if the Row Label grid (on Step 2) contains an item, it is displayed first in the request. If not, the system uses the first item present in the Column Label grid. If no row or column items exist, the first item in the Metrics grid is displayed.

Display Row and Column Headers: Adds a row and column to display these items.

In version 3.11, you could display a header for each item. Version 4 displays all of these items or none of them. If you created a request in version 3.11 and open it in version 4.x, report builder prompts you in Step 2 to update the range by one cell for items that are missing a header.

Change Headers to Excel Auto-Filters: Available only if row and column headers are displayed. This setting creates an Excel auto filter and appends it to the data report builder returns for this request.

⚠️ Note: Excel supports only one auto-filter per worksheet. If you create a new auto filter in a worksheet where an auto filter already exists, Excel does not provide a warning that the existing auto-filter is going to be replaced.

Perform Auto-Outline: Transforms the data returned by report builder from a list view to a tree view.

Name this Request: Lets you type a user-defined name for the request, or use the default name selected on Step 1. This name appears as the Report name in the Request Manager. See Name a Request.

6. Click OK.

Hide or Show Headers

This procedure describes how to hide or show headers.

Click Hide/Show in the Pivot Layout or Custom Layout output on the Request Wizard: Step 2 form.

Delete Output Mapping

If you are editing your workbook and want to make room for new requests, you might need to delete requests.

The only way to make room is to delete requests mapped to cells. If you delete requests in the spreadsheet by removing rows or columns, the underlying request validity is lost (and would fail on refresh). The Excel menu selection Edit > Clear Contents removes the value displayed in the cell. The contents can be restored by refreshing the contents of the cell.

To remove a specific mapping of spreadsheet cells, locate the row, column, or metric item and click Delete.

Name a Request

You can specify a custom name for your request, which displays in the Request Manager.
For more information, see *Format Display Headers*.

**Prepend and Postpend Text to Cells**

In *Pivot* and *Custom Layout* requests, for numeric or string values, you can prepend or postpend strings or characters to cells.

This option is available on the *Request Wizard: Step 2*.

- **Prepend Text**: Adds a prefix of numeric or string values in the cell.
- **Postpend Text**: Appends a numeric or string values in the cell.

**Configure the Custom Layout**

The *Custom Layout* provides most of the functionality of the *Pivot Layout*, but lets you choose where each item in the grid should be located in the spreadsheet. This layout provides the flexibility available in previous releases, including adding breakdowns and microcharts.

The following topics are unique to the *Custom Layout*:

**Map Metrics and Dimensions to Cells**

Before you begin to map items to the spreadsheet, ensure that your spreadsheet is not protected. If the protection scheme for your worksheet prevents any user actions, you will not be able to select cells in the spreadsheet. First, unprotect the sheet and then add cell mappings.

The number of areas and cells to map differs according to the metric you select, the granularity, the date range, and the filters you have set. For example, if you select *Site Metric > Traffic Report*, set *Week* granularity, and set date range for *Last 2 Weeks*, you are prompted to map three cells (when using *Custom Layout*) on the *Request Wizard: Step 2*. The request retrieves data for week one and data for week two, where each data point value = the value of a page view. Your third cell serves as the row heading, which you can configure using *Format Options*.

If you mistakenly map incompatible locations on the spreadsheet, report builder issues an error.

The following sections contain more information:

- **Selecting a Range of Cells**
- **Techniques for Selecting Cells**
- **Issues When Mapping**

**Selecting a Range of Cells**

On the *Request Wizard: Step 2*, when you enable *Custom Layout* for a trended request, you can map the request to a range of cells.

Click the *Range Selector* next to the item you want to map.

- **All Cells in Range**: Requires you to select a group of cells for a *Custom Layout* style request.
- **First Cell of Range**: Lets you select the top-left cell of the range, and displays the *Range* orientation to specify the horizontal or vertical orientation of input and output cells (column or row). Use this option to have report builder select cells for you.
- **Range Orientation**: Lets you orient the cell ranges as columns or rows.
- **Select Upper Cell Location of Range**: Displays the cell references.
Techniques for Selecting Cells

You select the data by clicking the **Range Selection** icon and click-dragging the mouse over the desired range of cells of the spreadsheet. A continuous selection is outlined by a black border.

Separate selected rows have a thin white border around each row.

To map separate rows in one request, use the **Control** key, then click and drag the cursor over the desired cells. You would do this if your request calls for four areas with ten cells each, rather than one continuous area with 40 cells together.

After you select cells, click the **Range Selector** again on the **Range Selection** form to return to the **Request Wizard**: Step 2.
**Issues When Mapping**

If you mistakenly choose to map to a cell that already has an active mapping, you will notice that no cell reference appears in the text box next to the range-picker icon. When you click **OK**, report builder displays the error, "The range selected intersects another request's range. Please change your selection."

- If you still need to use the cell, right-click on the desired cell or cells, and select **Delete Request**.

If you want to avoid this message, you can take two approaches:

- Plan the format of the report by adding formatting to the cells that have requests and mappings
- Test for areas of the spreadsheet containing mappings

To test for areas with embedded requests, you can:

- Launch the **Request Manager** and click on individual requests listed in the table. Clicking on the request highlights the cells of the spreadsheet where the request is mapped.
- Select cells in the spreadsheet you intend to use for a new mapping and click **From Sheet**. The **Request Manager** selects the request in the list which has an output item that intersects the selected cell. If no request is selected, then the cell is available.
- Select cells in the spreadsheet, right-click in the context menu and verify if **Edit Request** is available. If so, there is a request associated with these cells.

**Create a Microchart**

In the **Custom Layout**, you can turn a metric column into a bar chart with a corresponding percentage value, or a percentage value with a corresponding bar chart. The percentage value is the metric value or total for the overall non-filtered request for the period.

1. Create a request in Excel using the **Custom Layout**.
2. Right click the metric value column.
3. Select **Change Output Display**, then the type of microchart and percent display you would like to see.

The system changes the display in the column to match your selection.

**Filter Dimensions**

You can filter on dimensions that you add to the **Row Labels** grid. Filters narrow the data returned by requests and can be applied from the **Pivot** or **Custom Layouts**. When you configure dimension filtering from the **Pivot Layout**, you can additionally specify the number of entries from cell.

The selected filter form is populated based on the element & metric that is selected in the report builder request.

**Define Filter - Values and Special Characters**

Information about filters in the **Most Popular Filter > Define Filter** panel.
The following tables provide examples and information about filters:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
<th>Example Filter</th>
<th>Match Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains all terms</td>
<td>Contains every space-delimited value in any order.</td>
<td>a b c</td>
<td>Matches a b and b a, and so on.</td>
</tr>
<tr>
<td>Contains any term</td>
<td>Contains at least one of the filters (space-delimited).</td>
<td>A B C</td>
<td>Matches A1, B2, C3, but not D4.</td>
</tr>
<tr>
<td>Contains the phrase</td>
<td>Contains the search filter and possibly other terms.</td>
<td>abc</td>
<td>Matches abc and abc def.</td>
</tr>
<tr>
<td>Does not contain any term</td>
<td>Returns everything unless it contains a value you enter.</td>
<td>a b c</td>
<td>Matches d e f but not c d e f.</td>
</tr>
<tr>
<td>Does not contain the phrase</td>
<td>Returns everything that does not contain your phrase.</td>
<td>abc</td>
<td>Excludes abc, abc def and matches def</td>
</tr>
<tr>
<td>Equals</td>
<td>Returns an exact match.</td>
<td>abc</td>
<td>abc is returned, and nothing else.</td>
</tr>
<tr>
<td>Does not equal</td>
<td>Returns anything that does not exactly match your entry.</td>
<td>a</td>
<td>Does not match a.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Matches a b c.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Matches abc.</td>
</tr>
<tr>
<td>Starts with</td>
<td>Returns results that start with a specific value.</td>
<td>abc</td>
<td>Matches abcd but not 1abc</td>
</tr>
<tr>
<td>Ends with</td>
<td>Returns results that end with the specific value.</td>
<td>xyz</td>
<td>Matches wxyz but not wxy0</td>
</tr>
</tbody>
</table>
**Filter** | **Description** | **Example Filter** | **Match Results**
--- | --- | --- | ---
Advanced (special characters) | Lets you regex characters: "", ^, -, *, $, | "^Home*Page$" | This defines a filter that starts with Home, and then looks for zero or more characters, and then ends with Page. Also, any page with sports in it. A few example matches:

- HomePage
- Home and (other characters) Page
- Home sports
- sports Page
- sports
- xyz sports abc

| * | Wildcard | Same as the asterisk used in a regular expression. |
| ^ | Starts with | |
| $ | Ends with | |
| - | Not | |
| | Or | Supported only in the Advanced (special characters) filter. |

**Special Characters** | **Purpose** | **Notes**
--- | --- | ---
" " | Equals | Not escaped unless it is not paired with another quote. For example, 17" Display is not a phrase. |
* | Wildcard | |
^ | Starts with | |
$ | Ends with | |
- | Not | |
| | Or | |

**Most Popular Filtering**

Ranking and conditional filters that you configure using Boolean logic with AND/OR search expressions.

Most Popular filters are expression filters that you configure using Boolean logic with AND/OR conditions, such as Page does not contain <product name> with conditions or groups of conditions like Includes All, Includes Any, or Excludes All. You can save these expressions for other request in this workbook, or in other workbooks.

**To create a Most Popular filter**

1. Create or edit a request, and advance to the Request Wizard: Step 2.
2. On the Request Wizard: Step 2, click the link next to the dimension in the grid, then choose Filter.

3. On the Choose Page form, enable Most Popular, then configure the following options:

**Starting Rank:** The starting rank of a dimension. A default rank of 1 indicates the top item in the list of data reported. For example, for the dimension Page, a starting mark of 1 indicates the single most requested page of your site. You could specify 10 or another value as the starting rank cell, which produces a report starting with 10 as the highest. Metrics are arranged in descending order, so that line items with the greatest activity are reported first in the list. If you require more than 50,000 page names in one request, but have thousands of pages on which to report, you can copy the request and change the starting rank to retrieve the appropriate data in blocks of 50,000.

**Number of Entries:** (Pivot Layout only) Defines how many items are reported for a particular metric over a date range. Some metrics may list hundred of entries for a metric, while others may show just a few. For example, for the dimension Site Section, a number of entries of 25 indicates that the report shows the 25 most visited pages. Arrows allow you to change the Starting Rank and Number of Entries of the first data point in the sheet. By default, the Starting Rank is set to 1 and the Number of Entries to 10. These values are adjustable from a minimum of one to a maximum of 50,000 for certain metrics. Each metric has its own ceiling on Number of Entries. No negative values or zero are permitted in these fields. If you choose a Starting Rank as 15 and Number of Entries as 10, data requests for the metric return the 10 most visited pages, where the first most visited page is number 15 in the list for the specific date range. All the most requested pages ranked 15th to 25th are listed in descending order.

**Note:** Applying filters to existing requests causes changes in the data presented. Suppose you mapped the top ten Pages to cells $A$1 through $A$10, with 1 for Starting Rank and 10 for Number of Entries. If you change these values to show 1 for Starting Rank and only 3 for Number of Entries, the data previously filling cells $A$4 through $A$10 will no longer appear.
4. To create a search expression, click **Add**.

![Report Builder - Define Filter](image)

5. On the **Define Filter** form, configure the conditions appropriate for your needs.
   - **Add Condition** lets you locate a condition defined in the value of a cell.
   - **Add Condition**: Adds a condition to the expression. There is no limit to the number of conditions you can add.

6. Click **OK**.

![Report Builder - Choose Page](image)

7. On the **Choose Page** form, click **Save** to save the expression.
8. Click **OK**.

### Specific Filters

Filters that apply specific dimension terms.
You can search on specific dimension items by creating a filter that matches exact criteria. For example, you can create the following type of filter: page in `homepage.htm`, `contact_us.html`, `corporate_info.html`.

**To create a Specific filter**

1. Create or edit a request, and advance to the **Request Wizard: Step 2**.

2. On the **Request Wizard: Step 2**, click the link next to the dimension in the grid, then choose **Filter**.

3. Enable **Specific**, then enable one of the following options:
   
   **From Range of Cells**: Lets you select data from cells. You can select:
• **All Cells in Range:** Lets you map every cell for the range. Descriptive text explains how many groups of cells you must select. To map more than one group of cell, press the ctrl key as you are making successive selections. If the range that must be mapped contains only one cell, this is the only available option.

• **First Cell of Range:** You only need to select the upper left cell of the range, and then choose a direction for the data. Additionally, if the request has multiple periods, you choose the direction of the periods and choose whether you want to skip a set number of cells between periods.

**From List:** Lets you select data from a list to which you can add data.

4. If you enable **From List**, select any available listed items or click **Add**.

   When you click **Add**, the **Select From List** form displays a list of available dimension values for the current request date range, limited to the first 10,000 items. You can search across these items or click **More ...**, which displays the **Search Form**, so that you can create a more detailed search for dimensions.

5. On the **Select From List**, click **OK**.

6. On the **Choose Page** form, save your Specific filter if you want, then click **OK**.

**Saved Filters**

You can save filters or other parameters in report builder and use them in other worksheets or workbooks. These parameters are saved to Analytics, to ensure that they are available to other report builder users on other computers.

You save filters on the **Choose Page** form as you create a filter. For an example of this procedure, see **Specific Filters**.
Manage Requests

The Request Manager provides a detailed view of the status of all requests you have built for all sheets or just one sheet of the active workbook. You can also add, edit, refresh, and delete a request (functions typically associated with the Request Wizard and Request Manager) by right-clicking on an available cell in the Excel spreadsheet that contains previous requests.

The Request Manager displays when you click Manage ( ) in the report builder Toolbar.

Note: Adobe Report Builder enforces request dependencies only within the same worksheet, not across worksheets. Restricting to dependencies within a single worksheet ensures timeliness of execution.

Manage Requests - Definitions

Field descriptions for Manage Requests in Report Builder.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Sheets</td>
<td>Displays requests from all of the sheets of the active workbook. To view requests from specific sheets, turn off this option. If you turn off this option, you must click on a Sheet tab at the bottom of your Excel report to display the requests associated with that sheet in the Request Manager. The label next to the checkbox indicates which sheet of the workbook currently has the focus.</td>
</tr>
<tr>
<td>Sheet</td>
<td>Displays the name of the sheets in the workbook.</td>
</tr>
<tr>
<td>Report Suite</td>
<td>Displays the name of the report suite.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Displays the specified date range of the report.</td>
</tr>
<tr>
<td>Granularity</td>
<td>Specifies the granularity of the request.</td>
</tr>
<tr>
<td>Last Run</td>
<td>Specifies the date the request was last processed by Report Builder. A diagnostic message is also displayed in this table in the Last Run column, if applicable.</td>
</tr>
<tr>
<td>Add</td>
<td>Displays the Request Wizard dialog. See How to create a data request.</td>
</tr>
<tr>
<td>Edit</td>
<td>(Or Edit Multiple) Edits a selected request. The system displays the Request Wizard dialog. See Edit Multiple Requests.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes requests. You can delete multiple selected requests. You can also delete a request in the list by selecting the request and pressing Delete on your keyboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all requests. The Request Manager displays the number of requests you have selected at the bottom of the request list.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
From Cell | Gets data for a request from the worksheet. If a request is associated with the currently selected cell in the active worksheet, the associated request in the list is selected.
Refresh | Refreshes a single request or a selection of requests. (See [Refresh a Request](#).)
Refresh List | Refreshes all displayed requests. When you refresh all requests, the time to update the information from the server to your report is directly proportional to the complexity of the requests in the report. For very large reports, refreshing all requests may require several minutes. For this reason, you may wish to update the most urgent requests individually, and select **Refresh All** at another, less time-crucial moment.

**Note:** It is recommended that you check results often in the [Request Manager](#) if you refresh a worksheet containing multiple requests. If a request failure occurs, the error message in the diagnostic column helps you pinpoint the source of the error. While in most cases an error message is displayed when a request fails, note that occasionally no error message is generated. You may notice that a refresh does not update the data in a cell containing a reference, or that an update removes the data from the cell.

### Diagnostic Messages

Diagnostic messages provide you information about the status of the request when you refresh it.

- ✔️ Indicates that the request has been refreshed successfully since opening this workbook. The diagnostic column provides other information about the request, including the time used by the request, the time to map the request, and whether the request uses previously cached information.

- ⚠️ This alert is displayed when a request fails to refresh successfully. The error is noted in the diagnostic column pointing to the likely cause for the failure. Check the [troubleshooting section](#) for help with selected failure messages.

### Sort Ascending or Descending

You can sort the requests listed in the [Request Manager](#) in ascending or descending order.

Click on the columns names in the table header. The column shows the sort order by displaying a triangle icon in the table header. If the triangle is pointing down, sort order is descending (for alphanumeric data, 9-1 and Z-A), while if pointing up, the sort order is ascending (for alphanumeric data, 1-9 and A-Z).

The default sort order is ascending.

### Protected Worksheet Elements

If you protect your worksheet (by locking cells), you cannot create, edit, or refresh requests. Remove all protection from your worksheet before using Request Manager.
If you are refreshing the request and attempt to edit a cell during the refresh request process, an Excel error message advises you that the spreadsheet is currently protected. After the refresh request process completes, you can access the spreadsheet, and the temporary spreadsheet protection is removed.

**Edit Multiple Requests**

You can change several requests at the same time, based on the request's report suite, granularity, and date range. You can change several requests at the same time, based on the request's report suite, segments, granularity, and date range. For example, you can update a report's parameters so that all requests are based on the same report suite or segment, or you can transform a daily report into a weekly or monthly report, provided that you retain the same number of periods. You can edit multiple requests for the current worksheet or all worksheets of a spreadsheet.

**To edit multiple requests**

1. In Excel, click **Manage**.

   **Note:** To edit requests contained in cells of individual worksheets, clear the **All Sheets** option on the Request Manager. By default, this box is checked if there are requests on several worksheets.

2. On the Request Manager form, select two or more requests, then click **Edit Multiple**.

   The Edit Multiple Requests form displays columns of information: By Report Suite, By Segment, By Metric, By Date Range and Granularity, and By Group.

3. To group the display of requests, click any of the following options:
   - **By Report Suite**: Groups the display of requests by report suite.
   - **By Segment**: Groups the requests based on the segment name.
   - **Choose Segment**: Displays if no segments exist for the requests. To add segments, click Edit Group and select a segment from the Edit Group panel.
   - **By Metric**: See **Edit Metrics Across Multiple Requests**.
   - **By Date Range and Granularity**: Groups the display of requests by date range and time granularity.
   - **By Group**: Groups the display of requests by set of grouped requests.

4. On the Edit Multiple Requests form, click **OK**.

**Edit Metrics Across Multiple Requests**

The Edit Metrics Across Multiple Requests feature lets you easily add, remove, or replace metrics in a pre-existing request or across a group of requests.

*Add Metrics*

*Replace Metric*

*Remove Metrics*

Add Metrics

Keep in mind that
• Metrics can be added only to Pivot Layout requests. If some of the selected requests are Custom Layouts, metrics cannot be added. The reason is that Report Builder does not know where in the spreadsheet to place the new metric, since the layout is customized.
• Accordingly, if you have selected only Custom Layout requests, the Add Metric/s option is not available.
• Adding metric/s will increase the size of a request and may cause it to overlap with another request. Make sure your request has enough space around it to allow for adding metrics.
• If the metric added is already present in one of the selected requests, it will not be added to that request.

To add one or more metrics:

1. Select one or more requests in Excel and right-click to select Edit Metrics. (Or, click Manage > Edit Multiple > [choose metric] > Edit Group to select the group of requests to modify.)
2. Select Add Metric(s) and select the metrics to add.

3. Refresh the request to see actual data. Until you refresh, you will see offline data.

Replace Metric

Keep in mind that
• Only 1:1 substitutions are allowed, not 1:many or many:1.
• If the metric selected to be replaced is not present in one of the selected requests, this request is left unchanged.
• The new metric will be placed in the same location as the substituted metric. This means:
  • In a Pivot Layout: if a pivot layout request outputs date, visit, visitors, daily unique and "visitors" is replaced by "revenue", the updated request layout will be: date, visit, revenue, daily unique.
  • In a Custom Layout: if the "visitors" metric was output in cell F11, the updated request layout will show "revenue" in the same cell F11.
• If the substituted metric had some operation applied to it (average, pre-pended text, post-pended text, microcharting), these operations will also be applied to the new metric.

To replace a metric

1. Select one or more requests in Excel and right-click to select Edit Metrics. (Or, click Manage > Edit Multiple > [choose metric] > Edit Group to select the group of requests to modify.)
2. Select Replace Metric.
3. Select which metric to replace and which metric to replace it with.
4. Refresh the request. Until you refresh, you will see offline data.

**Remove Metrics**

Keep in mind that

- If any of the metrics selected to be removed are not present in one of the selected requests, this request is left unchanged.
- In a Pivot Layout, removing a metric causes the layout to shift for metrics that are located after the removed metric.

**Example**: if a pivot layout request outputs date, visits, visitors, daily unique, and you remove "visits", the updated layout for the request will show: date, visitors, daily unique.

To remove metrics:

1. Select one or more requests in Excel and right-click to select **Edit Metrics**. (Or, click **Manage > Edit Multiple > [choose metric] > Edit Group** to select the group of requests to modify.)
2. Select **Remove Metric(s)**.

3. Select one or more metrics to remove from the request.
4. Refresh the request. Until you refresh, you will see offline data.
Refresh a Request

You refresh requests after you update them with edits, filters, or you need to view more recent data. You can select several requests in a worksheet and refresh them all at once.

If you increase a request's date range and then refresh the request, report builder adds cells to accommodate the added number of periods.

1. Create and run a request.
2. After you have changed the request, right-click the request, then choose Refresh Request from the shortcut menu. (Alternatively, click in the request, then click Refresh in the toolbar.)

   The system displays the Refresh Requests form:

   **Now Date:** The date on which you want to base the refresh. Also known as the As Of date.

   **Set to Current date on Future Refresh Actions:** Enabling this option tells report builder to always use the current date as the Now (or As Of) date. You can revert this setting by clicking Options in the toolbar.

3. Click OK.

   When a refresh is successful, the system reports this with a green icon on the Request Manager.

Refresh Requests for All Sheets

You can refresh requests for all sheets or for multiple requests.

In order to refresh all requests, you must have access to all the report suites used in all of the requests. If your credentials give you access to only a subset of all the report suites in use, a warning message is displayed at log-in explaining that some of the requests cannot be refreshed. In this case, if you refresh all the requests, the requests to which you do not have access will not be refreshed.

When you refresh multiple requests, the system gathers and prioritizes requests based on whether a request is an original or dependent one. The system displays messages about the refresh progress. The refresh process can take up to several minutes, depending on the amount of data you are requesting.

1. Click Manage.
2. Enable All Sheets.
3. Click Refresh.
4. Specify a date reference, then click OK.

Add Dependent Requests

A dependent request is a request that is dependent upon an existing request.

For reports with correlation breakdowns enabled within the report table, you can take a closer look at an item by right-clicking in the cell and clicking Add Dependent Request > Breakdown.

*Note:* You can also add breakdown request while creating the original request. See How to create a data request.
Note: Adobe Report Builder enforces request dependencies only within the same worksheet, not across worksheets. Restricting to dependencies within a single worksheet ensures timeliness of execution.

See Breakdown Reports in Analytics Reference Help.

Classification

Classification breakdowns are used to map analytics reporting data to related properties. Classifications can be used for a variety of purposes but are most commonly used for classifying campaign tracking codes (both internal and external) and product IDs.

For example, a Campaign report might have a Manager classification and an Outlet classification. These classifications can then be ordered following a certain hierarchy, and each group of report values can be broken down into subgroups.

You access classifications in the same way you access the other reports of a report suite, and the dimensions are displayed as a top-level report within the group. If a report has classifications, a menu subgroup is created to collect the report and all its classifications in the same location. The report displays as the last entry in the list among the classifications.

See Classifications in Analytics Reference Help for information about how Reports and Analytics uses classifications.

Copy Requests

You can copy cells mapped with more than one request and paste the content to an empty, selected region of the spreadsheet.

After you copy cells, Report Builder and Excel determine the area required to paste the minimum amount of copies. If the area is large enough, the paste creates a copy of all the requests, where each pasted request has the same spatial arrangement and formatting as in the original requests.

This is known as propagating the request. This is an easy and quick way to create a long report. Report Builder first propagates the requests by pasting all the requests in the cells for the target paste region, then refreshes the cells based on the report dates established for the requests.

Copy Simple Requests

Copy a simple request rather than a referential request. A simple request is one that contains no references to another request or the contents of a cell.

A referential request uses values from cells as input for parameters, such as a data filter or relational filter. These filters use either matching or trending and are based on results of a prior request or on the user-entered contents of a cell, called an input cell.

1. Create a valid request.
2. Right click one of the cells where the request is mapped, or select a region of cells containing requests.

Be consistent in choosing a cell to copy from in the group of cells covered by the request. The preferred choice is the top and left-most cell of the set of cells covered by the request, and work from left to right. This is because the Excel spreadsheet has hundreds of columns and thousands of rows available for rightward and downward expansion. If you do decide to start a request copy from the rightmost or bottom cell in a set of cells associated with a request, the system does not allow you to paste the request if the cells to be pasted will extend beyond the left or top border of the spreadsheet.
3. Select **Copy Request**.

4. In another part of the spreadsheet, right click on an empty cell (a cell containing no request).

   To prevent you from losing or corrupting requests you have already created, you cannot paste cells containing requests to cells currently mapped with requests. If you copy or cut cells containing requests, the shortcut menu does not make the **Paste Requests** option available when right clicking on cells (or the set of cells) containing requests. You must select a different cell as the destination of the paste operation so that requests do not overlap. This applies whether you select a single cell with a request to paste or a region of cells containing requests.

5. Click **Paste Request**.

   A copy of the original request is placed in the cell(s), in a position or positions relative to the original request.

   **Note:** *Only requests are copied, not the contents of the cells. If you have other information not based on requests, but relevant to understanding the data displayed in the cells (such as table column headers or row identifiers), use Excel's standard commands Copy and Paste.*

Because Excel uses different clipboards for copying cell contents and copying requests, you can copy both non-request cell contents and then requests by performing a Copy/Paste and Copy Requests/Paste Requests in series. However, if you apply formatting to requests in the spreadsheet and then copy and paste, report builder reproduces the original formatting (such as borders, fonts, etc.) in the paste region.

Modifying a request that you have copied or cut to the clipboard before pasting the request removes the request from the clipboard. Therefore, to keep the request in its original state, do not modify a request between the time you copy it and the time you paste it.

### Copy Adjacent Requests

In the same way that you copy and paste requests, you can also relocate requests to another part of the spreadsheet by selecting **Cut Request** from the shortcut menu.

Cutting a request removes it from its original location and places it in the new location after you select **Paste Request**.

If you change your mind after cutting a particular request and decide to copy or cut a different request from another cell, Report Builder leaves the first request in its original cell and only acts (either copies or cuts) the second.

**Note:** *Report builder does not support the Excel Undo command for cutting or pasting requests. Therefore, be careful when cutting requests.*

You are not limited to copying and pasting in the same sheet of the workbook. You can copy a request in one sheet and paste to a location in another sheet of the same workbook.

You are not limited to copying and pasting one request at a time. You can select more than one request in the spreadsheet and paste them to an empty region of the spreadsheet. Just as with copying and pasting one request, make sure that the paste region has no cells with requests that will be replaced by the paste operation. If the system finds that the target paste region already contains one or more requests, report builder does not display the **Paste Requests** menu for any copied or cut requests. You must select a different cell as the destination of the paste operation so that requests do not overlap.

### Copy Worksheets

Copy one spreadsheet to another in the same workbook.
1. Right-click a cell anywhere in the spreadsheet and select **Copy Worksheet w/Requests**.
2. Right-click again and select **Paste Worksheet w/Requests**.

   A new worksheet is added to your workbook. By default, the worksheet has the same name as the original worksheet, but has the suffix (2). If you repeat the paste operation, the new worksheet has the suffix (3), and so on. When you paste a spreadsheet that you have copied, the new spreadsheet is located to the right of (immediately after) the active worksheet.

   Unlike copying and pasting requests, Report Builder copies and pastes directly entered cell contents (such as labels for column headers, rows, or formatting) when copying spreadsheets.

---

**Copy Requests and Worksheets between Workbooks**

Copy an entire spreadsheet in a source workbook to a spreadsheet in one or more target workbooks.

To do this, you must have at least two workbooks opened in the same instance of Excel: the first source workbook contains a spreadsheet (worksheet) with requests mapped to cells, while the additional target workbooks are the destinations. For each new target workbook, you should log in to the same report suite as the source workbook before you can paste spreadsheets containing requests.

1. Right-click the spreadsheet in the source workbook and select **Copy Worksheet w/Requests**.
2. In the destination workbook, right-click the spreadsheet and select **Paste Worksheet w/Requests**.

   The same instance of Excel means that only a single Excel process (excel.exe) is running on your computer at a time. If you launch two instances of Excel and attempt to copy a worksheet from a workbook in the first instance of Excel to a workbook in the second instance of Excel, Report Builder does not present the option to paste a worksheet in the shortcut menu of the second instance of Excel.

   If you log in to the source and target workbooks using different report suites, the only results you see from the paste operation are those affecting the formatting of the target workbook. Report Builder displays a message stating that the information for the requests derived from a specified report suite (in the source workbook) is not available in the target workbook. To reveal the requests pasted to the target workbook, you must log in to the target workbook using the same report suite as the source workbook.

   You can copy and paste one or more requests from a spreadsheet in one workbook to a spreadsheet in another workbook, as long as the second workbook is open as another document in the same instance of Excel. The requests in both workbooks must be created using the same report suite login.

---

**Create More than One Copy of a Request**

You can create more than one copy of an original request by filling a selected area of cells with as many copies of the request that will fit.

1. Select the request, then click **Copy Requests**.
2. Select as many blank cells necessary, then click Paste Requests.

   Report Builder fills the paste region with as many copies of the original requests as will fit, as long as the requests do not overlap the edge of the spreadsheet, or no requests already exist in the paste region selected.
Copy Referential Requests

A referential request uses values from cells as input for parameters, such as a data filter or relational filter.

To propagate or copy and paste referential requests in the spreadsheet, you must have created at least one valid request in the spreadsheet. In addition, the data produced by the request must contain a cell whose value is dependent on either a request in another cell (using a breakdown or matching filter) or dependent on a filter that takes input from data entered in a cell.

You can also create requests that reference input filters from requests in different worksheets, but not different workbooks. For example, a request in Sheet 2 can use a report suite from a given cell in Sheet 1 and a date range from a cell in a request in Sheet 2. The new output can be placed in either sheet or a new sheet within the same workbook. When you paste a relative request, if an input filter resides on a worksheet different from the worksheet on which the copied request output is located, the filter is pasted as an absolute filter.

💡 Note: You cannot output a single request in multiple worksheets. In addition, the system cannot paste some of the copied requests into new workbooks because the requests contain input filters from other worksheets. Input filters include report suites from cells, date ranges from cells, filters from cells, and other related parameters.

To copy referential requests

1. Select the cells containing requests you want to copy, including the input cell or referred to cell.
2. Right-click within the highlighted cells and select Copy Requests from the shortcut menu.
   After selecting the area where requests and input cells are located, the system highlights the cells with these elements.
3. Select either one cell or a range of contiguous cells to fill with the pasted requests.
   Make sure that the cell or cell range that you select contains no other data or requests.
4. Right-click the single cell or the top left-most cell in the range of cells and select Paste Requests.
   When pasting requests that include an input cell, the options under Paste Requests include:
   - **Use Absolute Input Cell**: Pastes a copy of the request(s) and formatting associated with the selected cells to the paste region you highlight. The input cell (the cell referred to in one of the original requests) is not pasted. Instead, the input cell remains in the same position as before.
   - **Use Relative Input Cell**: Pastes a copy of the request(s) and formatting associated with the selected cells to the paste region you highlighted, including a copy of the input cell. The spatial relationship of the request(s) to the input cell is the same as in the original request(s). However, while the newly pasted cells now have a copy of the requests, they have no content initially. This is because when the input cell is recreated in the paste operation, no data is associated with the input cell. To display data for the newly pasted request(s), you must enter a value in the input cell and then refresh the request(s).
Save a Workbook with Requests

After creating reports with embedded requests, you can save them by clicking File > Save or File > Save As in Excel. Report builder detects whether the report contains requests. When you click on either of these save options, the Save Workbook As form is displayed.

- As a best practice for any extensive work with Windows applications, Adobe recommends that you save your requests in the spreadsheet often and regularly to avoid an unexpected loss of requests in your worksheet.
- When naming your workbook, consider using a version number in the file name so that you can preserve a work history. For example, name your first workbook web_forecast_01_01.xlsx.
- If you have already saved the report, the Save Template form is not displayed when saving the report a second time. If the report contains no requests, this dialog box is not displayed. Instead, the standard Excel Save As form is displayed.

Filenames and Location

The Save Template form has some of the same functions as the standard Excel File > Save As dialog box, such as a text box for entering the file name of the spreadsheet report using the conventional .xls file extension.

Any file name you use must contain 255 characters or less. In addition, the file name may not contain the following characters:
\ ? | > < : / * ' "

Finally, you cannot use Unicode characters beyond the set of extended ASCII characters.

When saving the file to a location on your local or network drives, you may enter the full path in the text box, or click on the browse button adjacent to the Save As text box.

Specify Conditional Formatting

After creating reports with embedded requests, you can apply conditional formatting to cells of the workbook.

On the report builder Toolbar, click Format.

Conditional formatting lets you identify cells that contain results or values that you want to monitor. For example, you can apply red shading (or highlighting) to a particular cell if the revenue is below expectations, and blue shading if revenue exceeds amounts that you forecast. If a change in date ranges for requests removes conditions that cause conditional formatting to apply to cell values, the formats that highlight that condition are disabled temporarily. While the conditional formats you specify result in no change in display of cell format, because no conditions are met, they continue to be applied to cells until you remove them.

For security reasons, macros you write for the workbook using Excel’s Visual Basic for Applications (VBA) language are disabled.

💡 Note: Conditional formatting is an Excel feature. For information about creating formatting rules, see the Excel documentation.

Offline Mode for Creating and Editing Requests

Offline mode returns placeholder data to speed up the process of creating and editing requests.
When you create or edit new request, Report API calls are made to retrieve the response. This slows down the request creation process, because you have to wait for the data to return before going to the next step. Offline mode returns placeholder data only, so no API calls have to be made.

To enable offline mode:

1. Click **Options** in the Report Builder menu.

2. Check the checkbox next to **Turn on offline mode for creating and editing requests**.

3. In the **Display Metric Data as** field, enter the placeholder data that you want returned in your request. For example, enter "1".

4. Click **OK**.

5. Now create and run your request (in offline mode) using the Request Wizard.

6. Your request with "1" as the placeholder data will look similar to this:

   ![Image of report with placeholder data]

   **Important**: Make sure you disable Offline Mode before running your requests with real data. To do so, just go back to **Options** and remove the checkmark.
## Report Builder Options

On the Options panel, you can specify the date settings, latency settings (Current Data), log information, and configure updates.

In the Add-Ins toolbar, click **Options**.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>As Of Date</strong></td>
<td></td>
</tr>
<tr>
<td>Set to current date</td>
<td>Lets you specify or reset the <strong>As Of Date</strong> so that report builder uses the current date or asks you which date to use upon refresh.</td>
</tr>
<tr>
<td>Ask me to set upon refresh</td>
<td>Lets you set the <strong>As Of Date</strong> when refreshing a request.</td>
</tr>
<tr>
<td><strong>Data Recency</strong></td>
<td></td>
</tr>
<tr>
<td>Include Current Data</td>
<td>Lets you view data latency (also known as <strong>Data Recency</strong>) down to the minute in reporting, occasionally even before this data has been processed by Adobe Analytics.&lt;br&gt;&lt;br&gt;When you do not use this option, <strong>finalized mode</strong> (processed) is used, which is typically more <strong>latent</strong>.&lt;br&gt;&lt;br&gt;This setting applies to all requests in the workbook that are compatible Current Data. If the request is not compatible, the finalized mode is applied.&lt;br&gt;&lt;br&gt;Note the following situations for using the <strong>Include Current Data</strong> mode:&lt;br&gt;&lt;br&gt;<strong>Format Options</strong>: You can specify whether to display this information (Data Recency) when formatting display headers.&lt;br&gt;&lt;br&gt;<strong>Breakdowns</strong>: Not supported. If the <strong>Data Recency</strong> mode is set to the Current Data, and one of the requests contains a break-down element, this request reverts to non-current data mode. Other requests, however, continue to use Current Data mode.&lt;br&gt;&lt;br&gt;<strong>Request Manager</strong>: You can view a Current Data column in the Request Manager, so that you can see if the setting is applied to a scheduled request.&lt;br&gt;&lt;br&gt;<strong>Scheduled Workbooks</strong>: This mode is stored during the scheduling process at the workbook level. If you open a scheduled workbook that is using finalized data, and apply Include Current Data, current mode is used thereafter.&lt;br&gt;&lt;br&gt;<strong>Permissions</strong>: For users who do not have access to current data, this option is hidden.&lt;br&gt;&lt;br&gt;When enabling this option, if one or more requests cannot be applied, a warning is issued.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disable Current Data incompatible request warnings</td>
<td>Displays warnings if the Include Current Data mode is selected but the data mode cannot be applied to the edited request.</td>
</tr>
<tr>
<td></td>
<td>For example, if you set Include Current Data, and then edit a request that has a segment selected, a warning is issued.</td>
</tr>
<tr>
<td>Log report builder requests to local file (for troubleshooting)</td>
<td>Lets you log requests to a local file. Use this log file for troubleshooting.</td>
</tr>
<tr>
<td>Interpret typed value...</td>
<td>Interprets a typed value in a filter control as a cell location before considering it a filter expression.</td>
</tr>
<tr>
<td></td>
<td>For example if you create a Top 10 Page request, using a filter shoes, the request would display a cell containing something similar to:</td>
</tr>
<tr>
<td></td>
<td>Filter: Top 1-10 Page, Page contains Shoes</td>
</tr>
<tr>
<td>Update when a new version is available</td>
<td>Tells the system to notify you if a new version is available for installation.</td>
</tr>
</tbody>
</table>
Schedule Report Requests

You can schedule report requests, specify advanced delivery options, specify recipients, and view the schedule history. Advanced delivery options let you configure reports that you want to send at a specific time or in intervals. You can also specify the file format in which to send the report.

For example, you can schedule reports to be delivered immediately or on a recurring schedule, and specify the file format in Advanced Delivery Options. The file size limit is 5 MB for a report upload.

Additionally, after you create a report schedule in Report Builder, you can view and edit the schedule in Analytics > Reports. (See Report Schedule and Distribution in Reports & Analytics help.)

Note: You must have Excel 2007 or the compatibility pack installed in order to schedule a report.

Note: You can have a maximum of 10 scheduled workbooks per Report Builder license. However, you can increase this number by subtracting from other licenses. To do so, go to Admin > Company Settings > Report Builder Reports.

Note: A workbook that has been scheduled (or uploaded to the Workbook Library) and has not been touched (updated, replaced) in more than 28 months will be deleted.

See Specify Deliver Recipients and View the Report Schedule History for more information.

Schedule a Data Request

You can schedule reports to send according to the time and file format that you define.

To schedule a data request

1. Generate and save a report.
   - The Scheduled Reports tab summarizes all the tasks you have created, as well as the number of remaining tasks.
3. On the Scheduled Reports tab, click New.
4. The Basic Scheduling Wizard displays:
5. In the **Basic Scheduling Wizard**, configure the following options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Report</td>
<td>The name of the report. For new scheduled reports, this field is populated with the active workbook name.</td>
</tr>
<tr>
<td>Select</td>
<td>Displays the <strong>Select Report</strong> page. You can select a report from the server (where all your previously scheduled workbooks are stored), or from your local machine. If you select a workbook from the local drive in .xls format, the system converts the file to .xlsx. As part of that conversion, the file is opened in Excel and made active. If the selected workbook for the scheduled report has the same filename as the workbook currently open in Excel, the system selects the local file instead of the previously uploaded file. If you select a report from the scheduling repository, a copy of the workbook is created on the server, with its filename updated with 1, and the newly created scheduled report uses the copied workbook.</td>
</tr>
<tr>
<td>Customize</td>
<td>Lets you customize the date format.</td>
</tr>
<tr>
<td>To</td>
<td>Displays your Outlook Address Book, if applicable.</td>
</tr>
<tr>
<td>Send to: Email</td>
<td>The email recipient of the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Send to: Publishing List</td>
<td>Displays a list of available distribution lists for this company.</td>
</tr>
<tr>
<td>Power BI</td>
<td>See <em>Publish Workbook to Microsoft Power BI</em> for more information.</td>
</tr>
<tr>
<td>Subject</td>
<td>A user-defined description.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Lets you specify when to send the report. (Immediately, hourly, daily, weekly, monthly, and yearly.)</td>
</tr>
</tbody>
</table>

6. Click **Advanced Delivery Options** to configure file and publishing options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scheduling</strong> tab</td>
<td></td>
</tr>
<tr>
<td>Delivery Time</td>
<td>Lets you schedule the report immediately or for a later time. The time of day is relative to the time zone specified on your computer.</td>
</tr>
<tr>
<td>Recurrence Pattern</td>
<td>Sends the report based on your selections.</td>
</tr>
<tr>
<td>Range of Recurrence</td>
<td>Lets you specify when to start and stop receiving the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Scheduling a report on the first day of any current period (week, month, quarter, or year) returns data only for the first day.</td>
</tr>
<tr>
<td><strong>File Options</strong> tab</td>
<td></td>
</tr>
<tr>
<td>File Format</td>
<td>Lets you select a delivery format of Excel 2007 (.xlsx) or 2003 (.xls), .pdf, .csv, .mht, .txt, and .xml.</td>
</tr>
<tr>
<td>File Destination</td>
<td>Specifies Email or FTP. The options on the page change depending on your selection. For FTP, you must ensure that the host is available externally.</td>
</tr>
<tr>
<td>Publishing List</td>
<td>If you send the scheduled report to multiple publishing lists, the report runs once for each list. Variable report suites are replaced by the report suite assigned to the publishing list.</td>
</tr>
<tr>
<td>File Contents Language</td>
<td>Specifies the language you want to use for the cover letter. You can select Chinese (Simplified or Traditional), German, French, Japanese, Korean, Brazilian Portuguese, or Spanish.</td>
</tr>
</tbody>
</table>

**Publishing Options** tab
Publishing to Power BI

- Publish Workbook to Power BI
- Publish All Report Builder Requests as Power BI Datasets
- Publish All Formatted Tables as Power BI Datasets

Labeling details

7. Click **OK**, then click **Exit**.

Report Builder displays the scheduled report in the page 90.

Scheduled Task Manager

Field descriptions for the Scheduled Task Manager.

The Scheduled Task Manager lets you see a list of existing scheduled reports, along with their recipients, schedule details, and file formats. It also lets you reactivate scheduled workbooks that failed to run.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scheduled Reports</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Report Name</td>
<td>Indicates the name of the scheduled task.</td>
</tr>
<tr>
<td>Email/FTP</td>
<td>The email or FTP address of the recipient. <strong>Note:</strong> If email is selected, reports larger than 1 MB are automatically attached to the email as a .zip file. This feature helps keep attachment file size small and cannot be disabled.</td>
</tr>
<tr>
<td>Publishing Options</td>
<td>This column will list Power BI if one of the Power BI publishing options is selected.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The type of delivery scheduled.</td>
</tr>
<tr>
<td>File Format</td>
<td>The delivery format of the report, such as Excel, PDF, HTML, and so on.</td>
</tr>
<tr>
<td>Reactivate</td>
<td>When a scheduled workbook fails to run, Report Builder attempts to run the workbook two more times every fifteen minutes. After three failed attempts, Report Builder deactivates the schedule and displays the Reactivate button. When you reactivate a workbook, the scheduled delivery restarts from the time it became deactivated. For example, if a scheduled workbook was deactivated 14 days ago, and you reactivate it today, it runs for every missing day and will be delivered 14 times. If you do not want the workbook delivered for the missing days, you can delete the scheduled workbook and then create a new scheduled workbook using the same scheduling parameters.</td>
</tr>
</tbody>
</table>
**Note:** You should not reactivate a workbook unless you know the reason the system deactivated it. One troubleshooting solution is to download a deactivated workbook, and refresh it on the client side. If you see no errors, you should be able to reactivate it.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last sent</td>
<td>The date and time when the report was last sent.</td>
</tr>
</tbody>
</table>

**Recipient tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient email</td>
<td>The email recipient of the report.</td>
</tr>
<tr>
<td>Reports</td>
<td>The report/s that were sent to each recipient.</td>
</tr>
</tbody>
</table>

**Reports History tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Indicates the name of the scheduled task.</td>
</tr>
<tr>
<td>Date</td>
<td>The date and time when the report was last sent.</td>
</tr>
<tr>
<td>Status</td>
<td>The status indicates whether the report was Sent or Not Sent.</td>
</tr>
<tr>
<td>Email/FTP</td>
<td>The email or FTP address of the recipient of the report.</td>
</tr>
<tr>
<td>File Format</td>
<td>The delivery format of the report, such as Excel, PDF, HTML, and so on.</td>
</tr>
</tbody>
</table>
Workbook Library

The Workbook Library lets you upload a Report Builder Excel workbook that you want to share. You can also download and edit shared workbooks. When migrating from ExcelClient to Report Builder, it is recommended that you download workbooks from the ExcelClient repository and then upload them to the Report Builder repository.

💡 Note: Only workbooks with Report Builder requests can be uploaded. Also, you can distribute Report Builder reports to people who do not use Report Builder. (Users are not required to log in to see the data.)

Upload a Workbook

Upload a Report Builder Excel workbook that you want to share.

1. Create and run a request.
2. After you have saved the report, click Share.
3. Click Browse to locate the workbook.
4. In the Description field, type a description, then click Upload.

Download a Workbook

Download and edit shared workbooks.

1. In Excel, click Share.
2. Under Uploaded Workbooks, select the workbook and click Download.
3. Save the file.

The following options are available only to owners of a workbook:

- **Edit**: Downloads and opens a workbook for edit. If you want to upload a workbook that you downloaded for edit, you must do so manually.
- **Delete**: Lets you delete a workbook that you uploaded. You must be the owner of the workbook in order to delete it.

Lock/Unlock Workbooks

You can protect all requests in a workbook against adding and editing requests by locking the workbook. This enables offline editing of workbooks by pausing all report requests for more efficient editing.

As an analyst, locking a workbook lets you protect your workbook requests against tampering by other users within your organization. At the same time, those users can still refresh the requests in the workbook.

To protect a workbook against editing, click **Locked** on the Report Builder toolbar.

To unprotect a workbook, click **Unlocked**.

You can unlock a locked workbook if you have one of the following permissions:

- You are an administrator, or
• You are the person who initially locked the workbook. In this case, you do not have to be an administrator.

💡 Note: You cannot add a request to a protected workbook unless you have the permissions to unlock the workbook.

When a workbook is locked against request editing,
• Users cannot create/add requests.
• Users cannot edit requests through the Request Wizard.
• Users cannot edit requests through the Edit Multiple Request features.
• Users cannot cut, copy or paste requests. However, users can still use the native Excel Cut/Copy/Paste context menu to cut/copy/paste the content of the request(s).
• Users can refresh requests, either individually or as a part of a group.
• If the request uses input values from cells (date range, segment, filters), users can change these values in the cells, and thus indirectly edit the requests by refreshing them.

If you try to edit a protected workbook (through the context menu, or Request Manager, or Edit Multiple Requests), you may or may not be allowed to do so:
• If you do not have permissions to unlock the request(s), this prompt appears:

![Prompt](image)

• If you have the required permissions, no prompt is shown, and you can edit the request.

Workflow

Let's assume workbook A has one request which is in a locked state and was created by User A.

**Example 1: Admin User (or User A)**

1. User logs into Report Builder and opens a workbook A.
2. Workbook A is currently locked, so the “Create Request” button is deactivated in the toolbar, along with all other buttons whose functionality is disabled by locking.
3. If the user attempts to use one of the deactivated buttons, a message appears that the workbook is currently locked.
4. The user may unlock the workbook, which enables full editing functionality.
5. After unlocking, the workbook remains unlocked until explicitly re-locked.

**Example 2: Non-Admin User (User B)**

1. User logs into Report Builder and opens a workbook A.
2. User cannot add/edit the request.
3. User cannot unlock the workbook.

**Schedule Macro-Enabled Workbooks**

Adobe Report Builder supports the .xlsm format that lets you schedule macro-enabled workbooks. This can be useful if you need to safely schedule, process, and receive macro-enabled workbooks.

⚠️ *Important: Even though Report Builder lets you schedule workbooks with macros, these macros are not exercised during each scheduled run. They are only exercised when the workbook is open within the native Microsoft Excel application.*

Scheduled workbooks with macros can only be delivered in macro-enabled format (.xlsm), because all other supported formats (xls, xlsx, pdf, word, csv, or txt) would remove the macros from the workbook.
Publishing to Power BI with Report Builder 5.5

Microsoft Power BI is a suite of business analytics dashboards to analyze data and share insights. The Adobe Analytics integration with Power BI lets you visualize Report Builder Analytics data within Microsoft Power BI and easily share it across your organization.

Previously you, as an Analyst, would schedule Report Builder workbooks to be disseminated via email (or ftp). You can now give your business user stakeholders access (from within their Power BI accounts) to accurate and up-to-date data in a web-based environment that is accessible across platforms and devices.

Combining the report-generation capability of Report Builder with the visualization features of Power BI makes information more accessible to everyone in your organization. With Power BI, you can also integrate Adobe Analytics with other data sources (e.g. point of sale, CRM) to discover unique customer insights, associations, and opportunities.

The integration with Adobe Report Builder lets you

- Publish Scheduled Report Builder workbooks to Power BI
- Publish all Formatted Tables in the Workbook as Power BI Dataset Tables
- Publish all Report Builder Requests as Power BI Dataset Tables

System Requirements

- Adobe Report Builder 5.5 installed
- Active Microsoft account that enables you to sign in to Power BI

Publish Workbook to Power BI

Scheduled workbooks are formatted Excel spreadsheets populated with data from Adobe Analytics and sent on a regularly scheduled basis.

Publish Workbook in Report Builder

1. In Report Builder, generate and save a workbook.
3. In the Basic Scheduling Wizard, check the box next to Publish Workbook to Microsoft Power BI.
4. Specify your email and send immediately or specify the scheduling frequency (hourly, daily, etc.).
5. Click OK to publish.
6. You will now be asked to log in to your Microsoft account. Provide your credentials.
7. The Report Builder workbook gets scheduled and published to Power BI.

   With each scheduled instance, and after the Report Builder scheduling process has refreshed the workbook with updated Analytics data, the workbook will be published to Microsoft Power BI.

**View Report Builder Workbook Data in Power BI**

1. In Power BI, double click the workbook under the **Workbooks** menu.

2. You can now view the workbook dashboard data.
3. You can then pin an area of this workbook in order to include it in any of your Power BI dashboards.

**Publish All Formatted Tables in the Workbook as Power BI Dataset Tables**

💡 *Note: If the workbook contains a macro, the “Publish All Formatted Tables in the Workbook as Power BI Dataset Tables” will be disabled.*

Instead of importing the entire workbook, you can import only the content of all formatted tables within the workbook.

**Use case:** You have an Excel workbook that pulls data from multiple Report Builder requests and creates a summary table with lots of formulas. You can import only the summary table into Power BI and create a visualization for it.

**Publish a Formatted Table in Report Builder**

1. In Report Builder, generate a table of data that includes a header row, followed by a row of data.
2. Select the table and select **Format as Table** from the **Home** menu. The table gets named by default (Table 1, Table 2, etc.), but you can change the name on the **Design** menu.
3. On the Report Builder Toolbar, click **Schedule > New**.
4. In the Basic Scheduling Wizard, click **Advanced Scheduling Options**.
5. In the **Scheduling Wizard - Advanced**, on the **Publishing Options** tab, check the box next to **Publish all Formatted Tables as Power BI Dataset Tables**.
6. (Optional) You can customize the name of the published asset in Power BI. This can be useful if you use versioning as part of the workbook name (e.g., myworkbook_v1.1.xlsx) and you don't want the version number to show up in the name of the published Power BI asset. It has the added advantage that the published asset will not change if the version number changes. (View specifications here.)

View the Table Data in Power BI

1. In Power BI, go to the Workspaces > Datasets menu.

2. Select the dataset that you published and click the Create report icon next to it. Notice that the tables will appear as Fields.
3. Select a table and its associated columns.

4. From the **Visualizations** menu, you can select how to visualize a table in Power BI. For example, you could choose to present your data as a line graph:

5. From here, you can create visualizations from this dataset table.
Publish all Report Builder Requests as Power BI Dataset Tables

You can turn all your requests into dataset tables and build visualizations on top of them.

⚠️ **Important:** If the workbook contains more than 100 requests, only the first 100 requests will be published to Power BI. Plus, for each requests that is published to Power BI, only the first 10,000 rows of data will be published. So while these requests will be successfully delivered through scheduling, the scope of publishing to Power BI is limited.

1. In Report Builder, open or create a workbook with Report Builder requests.
3. In the Basic Scheduling Wizard, click Advanced Scheduling Options.
4. In the Scheduling Wizard - Advanced, on the Publishing Options tab, check the box next to Publish all Report Builder Requests as Power BI Dataset Tables
5. Click OK.

View the Request Data in Power BI

Each scheduled Report Builder request will be published as a table in the dataset. Each request table is named after the primary dimension in the request and it has a Report Suite and a Segments column.

1. In Power BI, go to the Workspaces > Datasets menu.
2. Select the request that you published and click the Create report icon next to it.
   Notice that the requests appear as tables in the Fields menu.
Note: No matter how you configured your Report Builder request to be laid out on the worksheet (pivot layout, custom layout, some columns invisible), Report Builder will always publish your request in the same two-dimensional, single header row format: Date, Dimensions, Metrics, Report Suites, Segments.

3. Also notice that there is an additional table called Legend. If you take a request out of the Report Builder context, it may be difficult to remember what each request stands for. The purpose of the Legend table is, for example, to show you the name of each request under Table ID. You can also add the other Legend columns to get a full view of the request.

Limitations and Specifications

- Power BI Publishing Restrictions
- Edit a Report Builder Request after Publishing to Power BI
- Change the Name of a Power BI Report

Power BI Publishing Restrictions

Note: These restrictions apply only to the option “Publish Report Builder Requests as Power BI Dataset Tables”.

• A maximum of 100 Report Builder requests can be exported to Power BI per workbook.
• The scheduling process will stop exporting requests when the 101th request is reached.
• Only the first 10,000 rows of Analytics data will be sent to Power BI per Report Builder request. The remaining rows will be ignored.

Edit a Report Builder Request after Publishing to Power BI

💡 Note: This specification applies to the options "Publish All Report Builder Requests as Power BI Dataset Tables" and "Publish All Formatted Tables in the Workbook as Power BI Dataset Tables".

Editing a Report Builder request after publishing it to Power BI may cause problems.

• **Case 1:** You publish a workbook to Power BI and create a visualization based on its data. Next, you make changes to the workbook, causing one of the columns of the data set that it references to disappear. Then you republish. This will break the visualization in Power BI.

  Here is an example of how the visualization WILL break:

  1. In Report Builder, create a workbook with one request, using the Page dimension and the Page Views metric.
  2. **Schedule this request** to be published to Power BI.
  4. Now edit the workbook by removing Page Views from the request.
  5. Edit the schedule with the updated workbook and re-publish the request to Power BI.
  6. Once the new workbook is sent to Power BI
    a. Verify that it overwrote the existing dataset that was created when you first published.
    b. Verify that the page_1 table is properly updated with the Page and Visits columns.
    c. Verify that your visualization is broken, since it references the Page Views column that is no longer present in the page_1 table.

  Here is an example of how the visualization will **NOT** break:

  1. In Report Builder, create a workbook with one request, using the Page dimension and the Page Views metric.
  2. **Schedule this request** to be published to Power BI.
  4. Now edit the workbook in Report Builder, adding the Visit metric while keeping Page and Page Views.
  5. Edit the schedule with the updated workbook and re-publish the request to Power BI.
  6. Once the new workbook is sent to Power BI
    a. Verify that it overwrote the existing dataset that was created when you first published.
    b. Verify that the page_1 table is properly updated with the Page, Page Views, and Visits columns.
    c. Verify that your visualization continues to work properly, since it references two columns that are still present in the page_1 table.

• **Case 2:** You pin a section of your workbook to a dashboard in Power BI and you later remove that pinned section (such as a chart or a table) from the workbook. This will break the visualization.
Change the Name of a Power BI Report

By default, the name will be populated from the workbook filename (without the .xlsx extension), except that spaces are replaced with underscore characters.

Keep in mind that

• The label cannot be a combination of letters and numbers that could be mistaken for a row and column address. For example, A100 cannot be a label because it is the address of a cell in a worksheet.
• The following characters are not valid label characters: ‘#’, ‘@’, ‘!’, ‘$’, ‘^’, ‘&’, ‘*’, ‘`’, ‘~’, ‘.’ . They will be replaced by an underscore character.
• When you enter an invalid name, a warning message will be shown that will suggest an auto-generated name. If you click Yes, this name will be used. If you click No, the Advanced Wizard UI will let you enter the new name.

Manually Import Data to Power BI

If you want to import Analytics data manually through Power BI, follow these instructions.

1. In Power BI, click Get Data in the lower left screen.
2. Under Import or Connect to Data > Files, click Get.

3. Click Local File.

4. Choose which file to upload and click Open.
5. Click Upload under Upload your Excel file to Power BI.
6. The message “Your file has been uploaded” should appear.

Pull Published Assets into Power BI Desktop

Explains how to pull Report Builder-published assets into Power BI Desktop

Prerequisites

• You need to have the latest Power BI Desktop version installed (April 2017 release)
• This process assumes that you have already published Report Builder formatted tables or requests to the Power BI Service.

Process

In the April 2017 update of Power BI Desktop, Microsoft released the ability to connect to datasets in the Power BI service. This feature allows you to create new reports off existing datasets you've already published to the cloud. You can leverage this feature to better collaborate and reduce duplicate efforts across your team.

1. In Power BI Desktop, go to File > Options and settings > Options > Preview features.
2. Enable Power BI Service Live Connection and click OK.
4. Once you have restarted the desktop, go to Home > Get Data > More....
5. Search for and select Power BI service.
6. Under Microsoft Power BI service > My Workspace, select the dataset that you had previously published from Report Builder.

For more information, see this Microsoft blog post.

**Best Practices**

**Preserve references in Power BI visualizations**

Once you create a request, that request will always have the same reference in Power BI. But if you delete a request, the reference will be used by a new request you create for the same dimension.

If you delete a request in your workbook, make sure you do not have a visualization pointing to that request in Power BI, because otherwise the visualization will break.

• If at all possible, do not delete requests you created in Report Builder
• Make sure that if you do delete requests on Report Builder, you also delete the corresponding visualization in Power BI.
• If you aren’t sure: delete requests you do not need any more, then republish and go to Power BI to see which visualizations have broken

**Troubleshooting Power BI Integration**

Here are a few common pitfalls when using Report Builder with Power BI.

• **1. Failure to Publish to Power BI**
• **2. Broken Visualizations in Power BI**
1. Failure to Publish to Power BI

Scheduled workbooks that require Power BI publishing are dependent on Power BI services to be up and running. Two main reasons for a failure to publish are:

• Power BI services may be down.
• The user who scheduled the workbook no longer has valid Microsoft account credentials.

Each Report Builder scheduled task gets three tries per scheduled run:

• After the first unsuccessful attempt, you will get this message: "We were unable to publish this scheduled workbook to Microsoft Power BI. We will try again shortly."
• After the second unsuccessful attempt, you will get no message.
• After the third unsuccessful attempt, you will get this message: "We were unable to publish this workbook to Power BI."

2. Broken Visualizations in Power BI

Here are the top reasons why you could end up with broken visualizations after publishing Report Builder requests to Power BI:

• You edited a request in Report Builder, such as changing metrics or dimensions and then republished to Power BI. Editing requests can break your visualizations.
• You deleted a request that was used in a visualization.

Adobe Analytics Content Packs for Power BI

Adobe Analytics Content Packs provide pre-built Power BI dashboards and a set of Power BI reports that deliver insights about your site traffic and user dimensions. You can use the dashboard and reports provided, or customize them to highlight the information you care most about. The data will be refreshed automatically once per day.

3 Content Packs are available:

• Adobe Analytics
• Adobe Analytics Mobile App Analytics
• Adobe Analytics Traffic Analysis

For more information, refer to the Adobe Analytics content pack for Power BI documentation.
Troubleshooting and Best Practices for Report Builder

Ways you can optimize report builder delivery, and a list of error messages that could occur occasionally.

• Report Builder 5.0 Users and Opening 5.1 Workbooks
• Authentication Issues in Report Builder
• Recommendations for Optimizing Requests
• Error Message Descriptions

Report Builder 5.0 Users and Opening 5.1 Workbooks
Adobe changed the separator between dimensions and classifications from an underscore character (_) to ||. This change has compatibility implications for a Report Builder 5.0 user who opens a Report Builder v5.1 workbook with classification requests. Each time a workbook from a version older than v5.1 is opened, all its serialized classifications requests will be converted to this format.

This introduces a forward compatibility problem: Once converted to v5.1, if a workbook is shared with a user on Report Builder v5.0, that user will not be able to recognize the classification request (indeed, it is looking for "_" but v5.1 serialized "||").

You will experience the following side effect when opening a ARB v5.1 workbook with classification request:

• When opening the workbook, you will get the following warning: “This workbook was last saved using Report Builder v5.1. This version has introduced some features that are incompatible with the Report Builder version installed on this computer. It is highly recommended that you upgrade to the latest Report Builder version before updating this workbook.”
• If you right-click an ARB request with classification, the Report Builder context menus (edit request, add dependent request...) will not show up.
• If you perform a Refresh All, by clicking the third button, or by refreshing a set of requests from the Request Manager form, the classification request will execute without error. However, the classifications values will not be written out.
• You can still edit the request by opening the Request Manager, then going from row to row, until it reaches the right request.
• If you edit the request and leave all parameters the same and then click Finish, the response will be properly written out. Indeed, editing the request resolves the problem as the Response Layout parameters are re-serialized. So there is a workaround, although it is time consuming.

Authentication Issues in Report Builder
Report Builder requires authentication to create data requests from your report suites. Sometimes there are issues logging in to report builder depending on your settings within Analytics or your network.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Login Company</td>
<td>This error most commonly occurs when either the login company is improperly entered, or if there are network activity issues. Do the following:</td>
</tr>
<tr>
<td></td>
<td>• Check the login company spelling to ensure that there is not a typo or an errant space.</td>
</tr>
<tr>
<td></td>
<td>• Log in to Analytics with the same login company to ensure that it is correct. If you are not able to log in with those credentials, contact one of your organization's administrators to obtain the correct login company.</td>
</tr>
<tr>
<td>Firewall</td>
<td>Report Builder uses ports 80 and 443. Ensure that these ports are allowed through your organization's firewall. See also Adobe's Internal IP Addresses for additional firewall exclusions.</td>
</tr>
</tbody>
</table>
Recommendations for Optimizing Requests

The following factors can increase request complexity and result in slower processing:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Factors that can slow down deliveries | • Too many bookmarks, dashboards, and Report Builder workbooks were scheduled within a few hours  
• Too many Report Builder workbooks were scheduled at around the same time. When this occurs, the report API queue becomes backlogged. |
| Factors that can slow down workbook runtime | • Significant increase in classifications.  
• Increasing the request date range over time.  
**Example**: Suppose you create a trended request using the **Current Year** setting, broken down by **Day** granularity. At the end of the year, the request will return more periods than the one created at the beginning of the year.  
(January 1 - January 30 versus January 1 - December 31.) |
| Causes that result in workbook delivery failure | Complex Excel formulas in a workbook, particularly ones that involve date and time. |
| Cells returning 0s (no values) | An apostrophe or single quote in the Excel sheet name will cause report builder to return no values. (This is a Microsoft Excel limitation.) |

Individual Request Performance

Processing speed can be affected by the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Faster Performance</th>
<th>Slower Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdowns and the breakdown order</td>
<td>Few</td>
<td>Many</td>
</tr>
<tr>
<td><strong>Example</strong>: If you break down A by Z, the number of items for A should always be less than the number of items for Z. If it is the other way around, the request time can increase significantly.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date range</td>
<td>Small range</td>
<td>Wide range</td>
</tr>
<tr>
<td>Filtering</td>
<td>Specific filtering</td>
<td>Most Popular filtering</td>
</tr>
</tbody>
</table>
| Granularity | Aggregated | • Hourly  
• Daily  
• Weekly  
• Monthly  
• Quarterly  
• Yearly |
| Number of entries | Small data set | Large data set |

Scheduling Time

Stagger scheduling over 24-hour period (see table below). Existing bookmarks, dashboards, and Report Builder workbooks scheduled close together may cause delays.
Schedule larger, more complex requests in the early morning to allow for manual pulls and refreshing to occur during the business day.

<table>
<thead>
<tr>
<th>Scheduling Time</th>
<th>1 a.m. - 2 a.m.</th>
<th>2 a.m. - 7 a.m.</th>
<th>7 a.m. - 6 p.m.</th>
<th>6 p.m. - Midnight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Builder usage</td>
<td>Quiet</td>
<td>Very busy</td>
<td>Client-side usage. Higher volumes of users refreshing locally and requesting to “Send immediately.” Additionally, verify whether the API queue is cleared when scheduled workbooks time out.</td>
<td>Not busy</td>
</tr>
</tbody>
</table>

Timeouts

Any scheduled report times out after four hours. The system attempts scheduling three more times, potentially resulting in a failure. (Generally, the larger the data set the longer it takes to run.) These can be seen in Analytics reporting and Report Builder:

- Analytics: Favorites > Scheduled Reports
- Report Builder: Click Management in the Add-ins tab in Excel.

Error Message Descriptions

A list of error messages that could occur occasionally while you are using Report Builder.

💡 Note: This is only a selection of error messages, and not an exhaustive list. For more information about resolving errors, contact your administrator.

This feature can only be applied on an open workbook.

If no workbooks (spreadsheet documents) are open in Excel, and you click one of the icons in the report builder toolbar, this message is displayed. In addition, the toolbar becomes disabled until you open a spreadsheet. However, you can click the on-line help icon while the toolbar is still enabled without causing this error.

You first need to exit the Request Wizard before activating the Request Manager.

While the Request Manager and the Request Wizard are linked functionally, it is not possible to start working with the Request Manager before completing or cancelling actions taken in the Request Wizard.

There is no request associated with this range.

This error message occurs if you click on the From Sheet button in the Request Manager when a cell of the spreadsheet contains no requests.

To identify which cells in the spreadsheet contain requests, click individual requests listed in the table in the Request Manager. If a request is associated with cells, the cells will show up highlighted when the request is selected in the table.

The selected Range is not valid. Please select another Range.
If a cell of the spreadsheet is selected and already has a request mapped to it, this error occurs. Either delete the request mapped to the cells or choose another range of cells to map.

When you want to delete cells, it is important to locate cells containing requests and delete the request before deleting the cells (removing rows or columns).

Please Exit the Excel Cell with focus before using this feature.

If you are in edit mode in an Excel cell and click one of the Report Builder icons, this error message appears. Edit mode in an Excel cell means that the cell is selected and the cursor appears inside the cell. You are also in edit mode in an Excel cell when you type directly into the Formula bar or into the Name Box at the top of Excel.

The range selected intersects another request’s range. Please change your selection.

If you have already mapped a set of cells to the spreadsheet, this error is displayed.

One way to determine which cells are mapped before adding new requests is to close the Request Wizard and open the Request Manager. Then, select items listed in the request summary table one by one. Whenever you select a request in the list, the corresponding cells containing request mappings in the spreadsheet are highlighted.

This is one reason you should consider marking cells with highlighting, row or column information, or a formatting style before mapping multiple cells to multiple areas.
Legacy ExcelClient

Important: SiteCatalyst 14, ExcelClient, and a number of other legacy components reached end-of-life in September 2016. This means that all access to the SiteCatalyst 14 user interface and several related features was removed. Here is a list of affected components, along with required user actions and suggestions on how to move forward with alternatives.

Differences Between Report Builder and ExcelClient

Report builder and ExcelClient are Excel add-ins that display data requests in worksheets.

Important: SiteCatalyst 14, ExcelClient, and a number of other legacy components reached end-of-life in September 2016. This means that all access to the SiteCatalyst 14 user interface and several related features will be removed. To prepare for this event, view this list of affected components, along with required user actions and suggestions on how to move forward with alternatives.

Report builder simplifies request layouts and adopts key features of ExcelClient, including the support of the same metrics, dimensions, and Pivot data layouts used in ExcelClient. You can also convert ExcelClient workbooks to report builder.

See ExcelClient Workbooks.

In most situations, you can run report builder and HBX Report Builder along with ExcelClient. When publishing a workbook, only the requests for that application are refreshed, so you must refresh all of them to keep them synchronized.

The following topics describe a few basic differences between ExcelClient and report builder:

• Toolbars
• Data Blocks
• Right-Clicking
• Workbook Library
• Data Refreshing
• Request Prioritization
• Keyword Management
• Data Discrepancies in Trended Ranked Reports

Toolbars

Both applications provide an add-on toolbar in Excel and let you log in using Analytics marketing report credentials (Company, Username, and Password).

ExcelClient Toolbars

The ExcelClient toolbars contain the following icons and text:

![Image of ExcelClient toolbars]
Report Builder Toolbar

The toolbar is shown below:

For more information, see Report Builder Toolbar.

Data Blocks

Report builder and ExcelClient use data blocks that dynamically reference cells within a worksheet. In both applications, you select the report suite, configure dates, and add metrics and dimension. However, report builder provides a more robust layout editor with features that let you copy and create dependent requests, and propagate the request by pasting it multiple times in the spreadsheet.

In report builder, if you increase the date range, columns are added to the request in order to accommodate the new dates.

Right-Clicking

In report builder, you can right-click a cell in a request and perform actions, such as launching the Request Wizard to edit the request, and to perform functions on multiple requests, such as editing, refreshing, and copying.

Workbook Library

Both applications use the Workbook Library in marketing reports to download and share requests. However, report builder and ExcelClient do not share the same repository. When migrating from ExcelClient to report builder, it is recommended that you download workbooks from the ExcelClient repository and then upload them to the report builder repository.

Data Refreshing

Report builder provides more ways to refresh requests and groups of requests than ExcelClient.

Request Prioritization

Report builder supports prioritization of requests, which is not supported in ExcelClient. Prioritization is available when one request is dependent upon another. For example, if a request's input comes from another request's output, both requests must be refreshed sequentially.

Keyword Management

Some versions of ExcelClient include the ability to manage keywords. Currently, report builder does not support this functionality.

Data Discrepancies in Trended Ranked Reports

Suppose you run a trended report with more than one dimension, and the data pivot on the dimensions. If at least one of the dimensions is not using a selected filter, ExcelClient and report builder report the top values differently. In this case, ExcelClient displays zeros for values reported outside of the request. Report builder, however, retrieves the data, because it performs a second request and applies the select filter.
ExcelClient Workbooks

You can run ExcelClient and report builder simultaneously. If you create and save a report generated in ExcelClient, and then log in to report builder, you can open the ExcelClient report and edit it in report builder. This action runs a conversion process. After conversion, report builder is the default reporting tool for the converted workbooks.

**Important:** SiteCatalyst 14, ExcelClient, and a number of other legacy components reached end-of-life in September 2016. This means that all access to the SiteCatalyst 14 user interface and several related features will be removed. To prepare for this event, view this list of affected components, along with required user actions and suggestions on how to move forward with alternatives.

**Note:** This process creates new Excel files. Adobe recommends that you create and organize directories to keep ExcelClient files separate from report builder files, which helps minimize confusion and the possibility of overwriting important data. It is also required to refresh your request after the conversion process.

When migrating from ExcelClient to report builder, it is recommended that you download workbooks from the ExcelClient repository and then upload them to the report builder repository.

**Convert an ExcelClient Workbook to Report Builder**

Step that describe how to convert an ExcelClient workbook to report builder.

1. Open a workbook containing the ExcelClient data block that you want to convert.
2. Click **Login**.
3. From the report builder toolbar, click **Manage**.
4. (Optional) On the ExcelClient to Report Builder Conversion wizard, specify whether to create a saved backup.
   - You might want to save the backup in the directory where you store other ExcelClient workbooks. When you back up the file, the system appends _backup to the filename.
5. Click **Convert**.
   - The system converts each data block and displays the status for each process.
   - A warning is issued if the request conversion is processed, but the query was updated. Errors are issued when the request conversion was not processed.
6. Click **Close**.
   - If you clicked **Manage** to launch the conversion wizard, the system opens the Request Manager after the conversion.
   - If you clicked **Create** to launch the conversion wizard, the system opens the Request Wizard after the conversion.
7. Save the request in your report builder directory.
8. In Excel, refresh the converted request.

**Convert Previously Scheduled ExcelClient Reports**

Using the **Schedule Manager**, you can convert published ExcelClient reports in an automated process.

1. Click **Schedule** on the report builder toolbar.
2. On the **Scheduled Task Manager** window, click **ExcelClient Published Reports**.

3. Select the one to convert, then click **Convert**.

The system downloads the workbook, converts it, then uploads it as a scheduled report. You can delete the old ExcelClient report. However, it is recommended that you have backups of all converted ExcelClient reports. If you do not delete the old one, two copies are delivered to recipients.

You can change distribution on the new one temporarily (or the old one). You can delete either product’s scheduled report, and you can validate and test both, then delete one at your leisure. It is recommended that you allow both to run for a while. After you are satisfied with the results, remove ExcelClient version from report builder.

💡 **Note:** *After conversion, you might modify the recipients list to include only yourself, so that you can test both requests. Then when you are satisfied, you can delete the ExcelClient version.*

### Conversion Warnings and Errors

Warning messages are issued when the request conversion processes successfully, but the query had to be updated slightly.

- **errConvertingCalculatedMetric:** Could not translate calculated metric {SAMPLE} so it was removed from the report.
- **errConvertingClassification:** Could not translate classification {SAMPLE} for element {SAMPLE} into the equivalent reportingAPI element.
- **errConvertingElement:** Could not translate element {SAMPLE} into the equivalent reportingAPI element.
- **errConvertingElementPrettyName:** Could not find the custom name for the element {SAMPLE}.
- **errConvertingMetric:** Unable to translate metric {SAMPLE} into the equivalent reportingAPI metric so it was removed from the report.

Error messages are sent when the request conversion was not processed. In this case, the affected ExcelClient web queries are still in the Excel file, and you can choose to remove them or keep them. If you keep them, the conversion wizard is displayed each time the workbook is opened.

- **errReportSuiteNotAvailableForConversion:** User does not have access to report suite id {SAMPLE}.
- **errConvertingFatalError:** An exception was thrown while converting report.
Release Notes

For recent release notes, go to Analytics section in the Experience Cloud Release Notes.
Contact and Legal Information

Information to help you contact Adobe and to understand the legal issues concerning your use of this product and documentation.

Help & Technical Support
The Adobe Experience Cloud Customer Care team is here to assist you and provides a number of mechanisms by which they can be engaged:

- Check the Experience Cloud help pages for advice, tips, and FAQs
- Ask us a quick question on Twitter @AdobeExpCare
- Log an incident in our customer portal
- Contact the Customer Care team directly
- Check availability and status of Experience Cloud Solutions

Service, Capability & Billing
Dependent on your solution configuration, some options described in this documentation might not be available to you. As each account is unique, please refer to your contract for pricing, due dates, terms, and conditions. If you would like to add to or otherwise change your service level, or if you have questions regarding your current service, please contact your Account Manager.

Feedback
We welcome any suggestions or feedback regarding this solution. Enhancement ideas and suggestions can be added to our Customer Idea Exchange.

Legal
© 2018 Adobe Systems Incorporated. All Rights Reserved.
Published by Adobe Systems Incorporated.

Terms of Use | Privacy Center
Adobe and the Adobe logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. A trademark symbol (®, ™, etc.) denotes an Adobe trademark.

All third-party trademarks are the property of their respective owners. Updated Information/Additional Third Party Code Information available at http://www.adobe.com/go/thirdparty.